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1 Modification History

Revision Date Comments
1.0 February 28, 2018 | Initial Release
<1.0.3.1 See ReadMe.markdown 1.0.3.1 included with the release
package.
>=1.0.3.1 September 26, See the section “What is new and what changed in version
2019 1.0.3.x”.

2 What is new and what changed in version 1.0.3.41

2.1 What is new

1. Added Export Mails option to more easily share mails with other people.
2. Added option to configure on how to open linked document.

2.2 What changed

1. Fixed print of footer and header enable/disable option.
2. Improved handling of Mbox File Parsing Cancellation.

3 LICENSE

The mbox viewer source code created by authors of the mbox viewer project is licensed under
GNU AFFERO GENERAL PUBLIC LICENSE version 3 which permits free use of the code by
individuals and organizations. Small portion of the source code is from Code Project site
and licensed under the Code Project Open License (CPOL) 1.02 which permits, as we
understand, free use of the that code except in a few unusual cases such as for example the
immoral usage. MailKit open source free library linked to connect to SMTP servers is
licensed under MIT.



The mbox viewer executable doesn't link any non-free usage library and therefore it can be
freely used, as we understand, by individuals and organizations.

The mbox viewer software is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE.

Please check the below links for the detailed information on GPL, CPOL and MIT license
terms.

https://mit-license.org/
https://github.com/jstedfast/MailKit/blob/master/LICENSE
https://www.gnu.org/licenses/agpl-3.0.txt
https://www.codeproject.com/info/cpoll@.aspx

Links to additional publications that can be useful.

https://www.codeproject.com/info/Licenses.aspx
https://opensource.guide/legal/#which-open-source-license-is-appropriate-for-my-project

4 About this document

Starting with 1.0.3.27 version of MBox Viewer, icons representing folders and mail archives have
changed. Mail archive used to be represented by the folder icon and now is represented as the stack
of mail envelops. Mail folder was represented by the computer icon and now it is represented by the
folder icon. However, not all screen snapshots were updated yet to reflect the change.

5 Feedback

To help to improve MBox Viewer, please post reviews what works and what doesn’t, create bug
reports and request for enhancements. Provide as many details as possible, such as country,
screenshots, etc.

6 Overview

MBox Viewer (or mboxview) is Windows GUI based program to view mbox files such as
Thunderbird Archives, Google mail archives or simple Eml files.

The mbox viewer is a simple but quite powerful email viewer that supports the following features:

large file support > 4Gb

fast parsing of mbox archives
quick access to all attachments
preview picture attachments
zoom in/out a picture

export of single mail in Eml

N ok W=

export of all mails in Eml format



8. export attachments of all mails

9. print all or multiple selected mails to CSV or Text or HTML or PDF files or send to PDF printer

10. print single mail to Text or HTML or PDF file or send to PDF printer

11. group all related mails as conversations

12. print mail conversation/related mails group to CSV or Text or HTML or PDF file or send to
PDF printer

13. open single or multiple selected mails or group of related mails in a browser

14. find user defined text in mail’s message and highlight all occurrences

15. search the date, subject, sender, cc, bcc, message text, appendix text and appendix names

16. search for mails that didn’t match the search criteria

17. sort by date, from, to, subject, size and conversation groups

18. support for mail’s header fields and body encoded with different character sets

19. support for mail list editing capability to enable users to compose mail list by merging results of
multiple searches and/or by merging one or more user selected mails

20. ability to set Message Window position to Bottom, Right or Left

21. ability to merge/concatenate multiple archive files and remove duplicate mails

22. ability to customize background colors of display panes and mail message

23. ability to customize HTML/PDF mail header output

24. view raw mail headers

25. forward mails directly from MBox Viewer

26. support for Gmail Labels

27. support for exported hierarchy of mail files from Thunderbird or similar mail clients

7 Known Issues

7.1 Running MBox Viewer

Only a single instance of MBox Viewer should be running at any given time. The second instance
of MBox Viewer is allowed when opening mail file directly.

7.2 Printing to PDF

MBox Viewer relies on Microsoft Edge and/or Google Chrome browsers to print directly to PDF.
Customization of printing is limited when printing directly to PDF.

Opening mails in a browser and printing from the browser offers additional options such as ability
to remove color in the output or scale the pages.

7.3 Printing Multiple Selected Mails

Mbox Viewer simply concatenates multiple mails in HTML format into a single HTML file and
opens the created file within a browser. The format of the created file is basically as follows:



<div><html><mail 1 header in HTML format></html></div>
<div><html><mail 1 body in HTML format></html></div>
<div><html><mail 2 header in HTML format></html></div>
<div><html><mail 2 body in HTML format></html></div>
<div><html><mail 3 header in HTML format></html></div>
<div><html><mail 3 body in HTML format></html></div>

The <div> tags are used in an attempt to create independent sections within HTML document.

The approach doesn’t always work reliably for variety of reasons. One known issue is that some
mails with content in HTML format rely on default values such as the font size and may inherit the
font size from other mails. MBox Viewer was enhanced to minimize such issues.

In rare cases, when printing multiple selected mails to PDF, use “Merge” option to resolve the
potential issues.

7.4 Mail Date and Time

Mails older than the epoch time, i.e. older than year 1970 are supported but the date and time of
such mails will be mapped to Jan 1 1970. Windows supports may different date and time functions
but only Unix style date and time functions support Daylight Saving Time. However, these
functions do not support date older than year 1970.

7.5 Searching

Search for words is quite reliable for words composed characters from ASCII and ISO-8859-1 (Also
known as ISO Latin 1) character sets. Option to search for words should not be set when searching
emails not composed from ASCII and ISO-8859-1 character sets.

8 Installation

The executable and the source code can be downloaded from Sourceforge or Github.

https://sourceforge.net/projects/mbox-viewer/files/

https://github.com/eneam/mboxviewer/releases

Download the executable package, the latest mbox-viewer.exe-v1.0.3.41.zip, to the working
directory and unzip. This will create the mbox-viewer.exe-v1.0.3.41 directory containing the stand-
alone mboxview.exe executable, User Guide, the scripts sub-directory and ReleasePlusStackTrace
sub-directory. No administrator privileges are needed to install and run the mbox viewer.

Review the HELP.txt file in case of the Mbox Viewer crash.


https://github.com/eneam/mboxviewer/releases
https://sourceforge.net/projects/mbox-viewer/files/

9 Running MBox viewer

The mboxview program can be executed by double clicking the executable from the explorer
window or from the command line by typing the command name and argument list to it.

9.1 Argument List Summary

The mboxview accept the following command line options.

-FOLDER-=folderPath — the full path to the folder containing one or more mbox or eml files.
Persists in the registry across multiple runs.

-MAIL_FILE=fileName — full file path or just file name of mbox/eml file to load. If the full path is
not specified, the full path is created from the folderPath and the fileName. Doesn’t persist in the
registry across multiple runs.

-EML_PREVIEW_MODE command line option to hide Mbox Tree and Mail List panes when -
MAIL_FILE is configured. ESCAPE key will terminate the mbox viewer.

-EXPORT_EML=y|n — enables or disables automatic export of eml files generated from mbox
archive. Improves traversing performance of mail if set to ‘n”. Persists in the registry across
multiple runs.

-PROGRESS_BAR_DELAY=seconds — search progress bar is activated when the search duration
lasts longer than the value set for PROGRESS_BAR_DELAY. If set to -1, the progress bar is
disables. Default value is set to 1 seconds. Persists in the registry across multiple runs.

-MBOX_MERGE_LIST_FILE=listFile Name and -MBOX_MERGE_TO_FILE=mergedFile
Name command line options to merge content of mbox files listed in the listFile Name. The merged
mbox file is automatically open in mbox viewer.

If desired, instead of typing directly desired command line options, a simple .cmd or .bat file can be
created for convenience and run from the explorer.

9.2 Setting Options from GUI

The EXPORT_EML and PROGRESS_BAR_DELAY values can be changed on the fly at any
time from GUI.

Click on the “File” to open the drop menu and then select the “Options” option. The below dialog
will be presented. Set the desired values followed by OK button.

Note that if exporting of EML files is disabled, you can still export the eml file for the selected mail
by selecting “View EML” under the “View” drop menu.

Two options, “Show Charsets” and “Set Character Sets for Header Fields”, can help to properly
display header fields in the Message Window. See 9.30.1.1 for additional details.



The “Picture Viewer” check box enables/disables the dialog option to preview the picture
attachments, see 9.24 for additional details.

The “Enhanced Select Mail Folder Dialog” is different version of the “Select Folder” option and
allows user to see if the mail archives are in the folder. User needs to select any mail file to select
containing folder.

The “Time” option allows to display time as Local or GMT.

The “Subject Sort Type” option creates subject threads when sorting by subject. Emails within
each subject thread are sorted by time. By default subject threads are sorted alphanumerically.
Subject threads can be sorted by time by selecting "File->Options->time ordered threads" option.

The “Validate files as mbox files” option enables user to control what files will be considered for
validation as mbox files. Validation is done based on the content of files.

Options >
Date format: (@) dd/mmfyyyy

() mm fdd fyyyy

2 yyyy fmm/dd

Time: (@ Local )GMT
Search progress bar startup delay in seconds

Export EML: ®no (yes
Message Header Character Set IDs (0-65001)
from to subject
Lo | [o | Lo |

Show Charsets: {_Jno (®) yes
Picture Viewer

[ Enhanced Select Mail Folder Dialog

Subject Sort Type
(®) alphanumeric (_) time ordered threads

Validate files as mbox files

(®) .mbox™=,.eml,no-extensions

) all files
Cancel

9.3 Basic Use Case

Double click of the mboxview to start the viewer. The picture below shows the screen created by
the mboxview after few steps performed by a user. Mail Archive, Summary and Message windows
are initially blank after start-up. Steps to load a mail archive and display the content are described
next.



B8 mboxriew - m] x
File Edit View Help

s | AllMaile Find Maik: User Selected Mals T e o
RN @ © ip Mail List Auditing Dialog Bar
=84 Mails date Qoa) t from to subject swe® | A
{9 apache.mbox R apache.org
Q) attachment.mbox 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... "Daniel Shahaf* <d.s@daniel.shahaf.name > Re: svnserve with corrupt tmestamps and malformed text representation 8
~2 linux-1996-05.em 09/01/201108:13  "RFL" <zhang. fan.work @ag.com> “Users” <users@subversion.apache.org>  svn: REPORT request failed on 'fsvn/lsvn/bcfonond s s 13
{0 linu-2001-07.eml | = 77122011 09:13 Péter_SZABADY <Peter SZABADY@igo...  ‘users@subversion.apache.org” <UsErs...  merge errer Mail Summary List 19
13 linu-2002-02.eml 16/08/2016 14:54  <webster brent@rogers,com> Subversion Users <users@subversion.a... My mixed revision working copy remains after a 'svn update' Windo 1
16/08/2015 23:49  Ryan Schmidt <subversion-2016@ryand... webster brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ w 7
18/08/2015 14:33  <webster.brent@rogers.com> Ryan Schmidt <subversion-2016@ryand... Re: My mixed revision working copy remains after a 'svn update’ 2
M 1A h 18/08/2015 14:55 Johan Corveleyn <jcorvel@amail.com> webster, brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 10
al rchive 04/10/2016 15:23 “Rainer Senn” <rainer.senn@senn-solut...  <users@subversion.apache.org> TortoiseSVN RepeBrowser: Feature request for Search function 7
Tree WiIldOW 05/10/2016 05:03 Torsten Krah <krah. tm@gmail.com> users@subversion.apache.org Re: TortoiseSYN RepoBrowser: Feature request for Search function 7 W
ISubject: newbie subversion questions Head M Wind
Date: 31/12/201013:00 From: shirish 319 <shirishag75@gmail.com> To: users@subversion apache.org eader o essage Window
Hi all, A
This is going to be a long post and actually a repost of what I asked
in Debian forum few days ago.
http://forums.debian.net/viewtopic.php?f=10&t=58798 but got no answer.
Mail Message/Body
This is from svn version 1.6.12 . .
Window
T am no programmer, just a user who sometimes downloads swn snapshots
or trunk builds and compiles them. My subversion skills are hence
extremely poor and hence need the forum expertise to know. Few
questions below :-
a. Ts there a way in subversion when you are downloading some new
project progress as in megabytes downloaded etc. &n excerpt so it will
make clear what I am asking :-—
$ svn co https://pagesofadventur.svn.sourceforge.net/svnrcot/pagesofadventur
pagesofadventur
A pagesofadventur/trunk
A pagesofadventur/trunk/.classpath
s pagesofadventur/trunk/COMPILING
n pagesofadventur/trunk/comp v
F:N pagesofadventur/trunk/LICENSE
Ready Mail Retrieval Complete  Mail 1 of 17

1. Click on the “File” to open the drop menu and then select the “Select folder...” option.
Browse to the folder containing one or more mbox and/or eml mail archive files and select
it. All valid mail archive files will appear in the Mail Archive Tree window.

Note that different “Select Folder” dialog can be configured via File — Options menu
dialog.
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B mboxview

File Edit View Help
Select folder...
Refresh
Options...
Print Config...
Attachments Config...
Color Style Config
Print To
Merge Archive Files...
Restore Hint Messages

Development Options
most recent folders

Exit

F2
F5

Bl Mails Found Maile User Selected Mails Help

lect: <empty>

<empty> From: <empty>

Select folder containing mails

To: <empty>

2. Left click on one of the archive files to load all mails within that archive. Progress bar will
appear and automatically close after the selected archive is fully processed. Mail header
information of each email will appear in the Summary window. Note that parsing of very
large archive file may take some time since the mail archives are text files and every
character has to be examine one by one.

However, subsequent loading of mails is done from the index file created by the mboxview
during the initial parsing of the archive file and is much faster. The created index file
contains content meta data of each mail in the archive file. i.e. the mail header information
and the position of each mail within the mail file for quick access to the mail message/body.
The index files have the .mboxview suffix.
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&) mborie - o x

File Edit View Help

H j;\ \ 7 | ||o-\ 21l Mails Found Mails User Selected Mails Help
-3 Mails
l g apache.mbox Subject: <empty>
{59 attachment.mbox From: <empty>
-5 linux-1996-05.eml To: <empty>
* 5 linux-2001-07.eml CC: <empty>
L ER) linux-2002-02.eml BCC: <empty>

Date: <empty:>

Please Wait.. X

Parsing archive file to create index file .. 300

Opening linux-2002-02.em .

3. Left Click on one of the mails in the Summary window to show the Message/Body of that
email in the Message window. The mail retrieval state, total number of mails in the archive
and the position of the selected mail within the archive is shown on the status bar. Opening a
heperlinks within an external browser is recommended since running Java or scripts or
ActiveX controls is disabled in the internal browser to improve security.

(&) mboxview - m] x
File Edit View Help
= %] @ Al Mails O Find Mails User Selected Mals Help
=43 Mails || date (Local) from o subject size(kB) | ™
{23 apache.mbox ‘ K
30/06/200109:57 Pavel Machek <pavel@suse.cz>  James Simmons <jsmmons@transv.., Re: [ANNOUNCE] Secondary mips tree., 3
= “_ﬂa‘“’"e"t mbox 02/07/200108:47 2T <cosmos@astonlinux.com>  Ralph Metzler <rikm@convergenc...  Re: Help me. 5
g 'f"”*'1995'°5-em' 02/07/2001 10:06 "Maciej W. Rozycki® <macro@ds2.... Harald Koerfgen <Harald koerfge... linux 2.4.5: A DECstation HALT interrupt handler 5
{5 linusc-2001-07.eml 02/07/2001 11:05 Ralf Baechle <ralf@oss.sgi.com>  "Maciej W. Rozycki” <macro@ds2.... Re: linux 2.4.5: A DECstation HALT interrupt handler 2
{2 linux-2002-02.eml 03/07/200106:05 _ Ralf Baechle <ralfi@oss.sgi.com>  Raghav P <raghav@ishoni.com>  Re: Are page tables allocated in KSEGO or in KSEG2? 3
03/07/2001 17:48  “Steven Liu™ m>  <linux gi,com sti() does not wark. 2
04/07/200105:23  Thiemo Seufer <ica2_ts@csv.ica.u... linu-mips@oss.sgi.com Re: sti() does not work. 3
04/07/200107:23 “Gleb O. Raiko™ <raiko@niisi.msk.ru> Thiemo Seufer <ica2_ts@csv.ica.u... Re: stiQ) does not work. 3
04/07/200108:26 Ralf Baechle <ralf@oss.sgi.com»  Thiemo Seufer <ica2_ts@csv.ica.u... Re: sti() does not work 3
04/07/200108:29 RalfBaechle <ralf@oss.sgi.com»  Steven Liu <stevenlu@psdc.com>  Re: stiQ) does not work. 3 v
ISubject: Re: Are page tables allocated in KSEGO or in KSEG27
Date: 03/07/200106:05 From: Ralf Baechle <ralf@oss.sgi.com> To: Raghav P <raghav@ishoni.com>
~
On Sat, Jun 30, 2001 at 02:51:17PM +0330, Raghav P wrote:
1 was going thru the TLB exception for R2300 and had the following doubts
= which T hope someone can help me out with. ( am sorry if this is a newbie
> question but since this is MIPS specific I am posting here)
>
= The code is in arch/mips/kemnel’head.S for user TLB:
>
= /* TLB refill. EXL == 0, R[23]00 version */
> LEAF(except_vec0_r2300)
> set noat
> set mips]
=mfc0 k0, CP0_ BADVADDR
= 1w k1. current_pgd # get pgd pointer
=srlk0, k0, 22
=sll k0, k0, 2
=addukl, k1, k0
>mfc0 k0, CPO_CONTEXT
= Iwkl, (k1) v
Ready Meail Retrieval Complete Mail 5 of 383

9.4 Multiple Folders Support

Each time you click on the “File” to open the drop menu and select new mail archive folder via the
“Select folder...” option, the selected folder will be added to list of folders under the Mail Archive
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(@ mboxview x
File Edit View Help
=] 7= @® Al Mails O Found Malke User Selected hails Help
%4 Linux1 | date (Local) 1 from o subject size(kE)
-3 apache.mbox 31/12/2010 13:00  shirish f¥¥1S <shirishag7S@gmail....  users@subversion.apache.org newbie subversion questions 7
I attachment.mbox 04/01/201108:08 René Hjortskov Nieken <rene@hio... "Daniel Shahaf™ <d.s@daniel.sha...  Re: svnserve with corrupt timestamps and malformed text representation 8
1D linux-1996-05.eml 09/01/201108:13 B5F." <zhang.fan.work@qq.com>  “users” <users@subversion.apach... svn: REPORT request failed on 'fsvn/1svn/bcfiococ 3
-1 linux-2001-07.eml 07/12/201109:13 Péter SZABADY <Peter SZABADY... ‘users@subversion.apache.org” <... merge error 19
12 linux-2002-02.eml 16/08/2016 14:54  <webster brent@rogers.com> Subversion Users <users@subvers... My mixed revision working copy remains after a 'svn update’ 18
-9 Linux2 16/08/2016 23:49 Ryan Schmidt <subversion-2016@... webster.brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 7
-3 apache.mbox 18/08/2016 1433 <webster,brent@rogers.com> Ryan Schmidt <subversion-2016@... Re: My mixed revision working copy remains after a 'svn update’ 21
{2 attachment3.mbox 18/08/2016 14:55  Johan Corveleyn <jcorvel@gmail....  webster.brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 10
[ inline_attachmentem |  04/10/2016 15:23 "Rainer Senn” <rainer.senn@senn-,.. <users@subversion.apache.org>  TortoiseSVN RepoBrowser: Feature request for Search function 7
123 linux-1996-05.em! 05/10/2016 05:03  Torsten Krah <krah, tm@gmail.com: n.apache.org Re: TortoiseSVN RepoBrawser: Feature request for Search function 7
£ linux-2001-07.eml 05/10/201606:35  Daniel Shehaf <danieish@apache.... Rainer Semn <rainer.senn@senn-s... Re: TortoiseSVIN RepoBrowser: Feature request for Search function 5
[ linux-2002-02.em 06/10/201603:42  Johan Corveleyn <jcorvel@gmail....  Daniel Shahaf <danislsh@apache.... Re: TortoiseSVN RepoBrowser: Feature request for Search function 7
) message-from-start-t 26/07/2017 12:15  Daniel Shahaf <danielsh@apache.... ~amnoun: on.apache.org...  [ANNOUNCE] Apache Subversion 1. 10.0-alpha3 released 7
(5 message-from-start-t 31/10/2017 13:06  Vincent Lefevre <vincent in... n.apache.arg Re: Error E60015 "... is not a directory in flesystem ...” 4
07/02/2018 08:06  Nico Kadel-Garcia <nkadel@gmail.... Erarko Cibej <brane@apache.org>  Re: svn diff non-temparary files option [
10/02/2018 02:59  Thorsten Schining <tschoening@a... users@subversion.apache.org Does svn dient binary honors LANG env variable on Windows? &
18/02/2018 08:40  Ignacio Gonzlez (Eiiop) <igtorqu...  users <users@subversion.apache...  Not so cheap moves 8
ISubjer:t: svn: REPORT request failed on 'fsvn/!svn/bc/xoo
Date: 09/01/201108:13  From: "3F," <zhangfanwork@qg.com=  To: "users” <users@subversion.apache.org>
~

Hi , all
Here is my problem:

When I run svn log on my repository which version is 1.6.x with Apache 2.2 on Windows 2003 have suddenly begun getting an error message in their log

windows:
Error REPORT request failed on '/[path_te_repol/!svn/bc/21008" 200 OK (http://[server_name])
Then T checked the log of apache, get like this v
< > \liezsee 03— [09/Tan/2011-92-00-98 08001 "OPTIONS eyn HTTP/L 1" 401 401
Ready Mail Retrieval Complete Mail 3 of 17

Use +/- icon on the toolbar to expand/collapse the list of archive file under all folders.
To remove folder from the list:

1. Left click on the folder to select the folder and then

2. Right click on the folder and select Delete Folder menu option

List of the selected folders will persist across multiple runs.

9.5 Support for Hierarchy of Folders

MBox Viewer can automatically open mail files residing under the root folder and all sub-folders.
Using this capability, user can more easily view emails exported by Thunderbird or similar email
clients.

User can select one of two options to leverage this feature.

1. Select “File — Select folder as root folder ...” option. MBox Viewer will traverse root folder
and all sub-folders and recreate folder hierarchy under the Mail Tree.

2. Select “File - Select root folder for merging ...” option. MBox Viewer will traverse root
folder and all sub-folders, merge all discovered mbox files and recreate folder structure as
Gmail style labels. Duplicate email will be removed.

Option 2, that is merging, allows searching across all discovered mail archives while option 1
allows searching within each mail file only.

Screen snapshot illustrates both cases when applied to the same Thunderbird folder.
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(&8 mboxview
File Edit View Help
= | + || (®) Al Mails () Faund Mails () User Selected Mails Help

Pl

- MailAccounts
=-f=3 Thunderbird.mbox

date (Local) 4 from w© subject
shirish RS

Subject: {/0) newbie subversion questions

M Sent René HJ”SI““ N... Danicl Shahaf Re: svnserve with corr From: (UTF-8/65001) s?_ﬁlrlsh fardy <shirishag75@gmail.com=
INBOX AL users swn: REPORT request - | 19- (/0) users@subversion.apache.org
E1-® Project.sbd B 12/07/201109:13 Péter SZABADY users@subversi... merge error Date: (Windows-1252/1252) 12/31/2010 13:00
Sub-project-1.sbd 0B/16/2016 14:54 webster brent Subversion Users My mixed revision work
-~ database 08/16/2016 23:49  Ryan Schmidt webster brent Re: My mixed revision .
® diagrams 08/18/2016 14:33  webster.brent Ryan Schmidt Re: My mixed revision || Tt all.
5B Sub-project-2.sbd 08/18/2016 14:55 Johan Corveleyn  webster brent Re: My mixed revison | LIS is going to be a long post and actually a repost of what I asked
: b viewer 10/04/2016 15:23 Rainer Senn users TortoiseSVM RepoBrow [ 111 Debian forum few days ago.
-3 Thunderbird 10/05/2016 05:03  Torsten Krah users Re: TortoiseSVN Repot || http://forums.debian net/viewtopic. php?f=10&t=38799 but got no answer.
& INBOX 10/05/2016 06:35  Daniel Shahaf Rainer Senn Re: TortoiseSVN Repot
&9 Sent 10/06/2016 03:42  Johan Corveleyn  Daniel Shahaf Re: TortoiseSVN Repot | This is from svn version 1.6.12
£ Project.sbd 07/26/2017 12:15  Dariel Shahaf announce [ANNOUNCE] Apache ¢
55 Sub-project-1.sbd 10/31/2017 19:06  VincentLefevre  users Re: Error E160016 .. | <quote>
— 02/07/2018 08:06 Nico Kadel-Garca  Branko Cibej Re: svn diff non-tempe s
] datebaze 02/10/2018 02:55  Thorsten Schaning  users Does oun chentbinary. || Lo LE
&= diagrams - onng ¥ || 1 am no programmer, just a user who sometimes downloads svn snapshots
02/19/2018 08:40  Ignacio Gonzlez ... users Mot so cheap moves

=) Sub-project-2.sbd or trunk builds and compiles them. My subversion skills are hence
= viewer extremely poor and hence need the forum expertise to know. Few
questions below -

a Is there a way in subversion when vou are downloading some new
project progress as in megabytes downloaded etc. An excerpt so it will
make clear what I am asking :-

$ svn co hitps://pagesofadventur svn sourceforge net/svnroot/pagesofadventur
pagesofadventur

A pagesofadventur/trunk

A pagesofadventur/trunk/ classpath

A pagesofadventur/trunk/COMPILING

A pagesofadventur/trunk/compile.sh

A pagesofadventur/trunk/ LTICENSE

A pagesofadventur/trunk/ project

A pagesofadventur/trunk/lib

A pagesofadventur/trunk/lib/libopenaléd so

Ready Mail Retrieval Complete Mail 1 of 17

9.5.1 Select Root Folder for Merging Configuration Dialog

The following dialog is presented to users upon selection of the “Select root folder for merging..”
option. In addition to support for folder hierarchy and Gmail style labels, other useful options for
merging mbox or eml files are supported.

Merge Root Folder and Sub-folders Configuration X

This dialog enables users to configure root mail folder and sub-folders
for merging mbox files exported from the same mail account.

Select "Assign no Labels" option when merging Gmail mail files.
Select "Assign no Labels” or "Assign same label to all MBOX files per
containing folder" option when merging thousands of mail files.

() Merge Root Folder (@) Merge Root Folder and Subfolders

(7) Assign no Labels

(®) Assign a label per each MBOX file

(") Assign same label to all MBOX flles per containing folder




9.6 Data Folder Configuration

MBox Viewer will generate files and save them in the user selected data folder when executing
some of the options such as “Print To...”, Export All Mails as Eml ..”, etc.

User can select data folder by selecting “File-->Data Folder Config” dialog.

Data Folder Configuration X
This dialog enables users to configure root data folder. MBox Viewer will create

UMBoxViewer folder under the configured root data folder for all files generated by
MBox Viewer such as mails exported in PDF format.

!!! Data Folder path should be as short as possible to avoid truncation of names of files
generated by MBox Viewer. Note that the file path is limited to 255 characters.

Current Data Folder

Select Mew Data Folder

G:\DataFolderd4\

OK Cancel

9.7 Hiding and Restoring Mbox Files in Mail Archive Tree
Window

User can hide some mbox files temporarily if he is not actively working with these files and restore

hidden files later when needed. To hide an mbox file, right click on a file and select “Remove File”
option.
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(&) mboxview x
File Edit View Help
@3] 7|+ =] ®) Al Mails (O Found Maiks (O User Selected Mails Help
-4 Linux | date (Local) 1 from o subject sint o
{2 apache.mbox 30/06/2001 09:57  Pavel Machek p! 5 Re: [ANNOUNCE] Second: 3 Subject: Re: Help me.
o SR Sl = SConten From: ZH:l3 <cosmos@astonlinux.coms
I attachment.mbex 02/07/2001 08:47 Ralph Metzler 5 i il ) @
-3 linux-1996-05.eml 02/07/2001 10:06 Maciej W. Rozydd Harald Koerfgen  linux 2.4.5: A DECstation H... 5 To: Ralph Metzler <rjkm@convergence.de>
-3 linux-2001-07.eml 02/07/2001 11:05  Ralf Baechle Madej W. Rozycki  Re: linux 2.4.5: A DECstati... 2 ICC: linux-mips@fnetfr, linux-mips@ass.sgi.com
-0 message.eml 03/07/2001 06:05  Ralf Baechle Raghav P Re: Are page tables aloca... 3 Date: 02/07/2001 08:47
599 Linux2 03/07/2001 17:48  Steven Liu linux-mips sti) does not work, 2
() apache.mbox 04/07/200105:23  Thiemo Seufer  linuscmips Re: sti() does not work. E ~
{3 attachment3.mbox 04/07/200107:23  Gleb O. Raka Thiemo Seufer Re: sti) does not work. 3
(3 inline_sttachment.em | 04/07/200108:26 Ralf Bazchle Thiemo Seufer  Re: stiQ) does not work, £
i) linux-1996-05.eml 04/07/200108:29  Ralf Bacchle Steven Liu Re: stiQ) does not wark. 3
5] linux-2001-07. R —— linux-mips Kernel panic: Attempted to ki.. 4 Ralph Metzler wrote:
{2 linuwe-2002-02.e1 Print To > linusc-mips RTLinu for Mips 2
{2 message-from-+ in Re: Kernel panic: Attempted t. 4 - Hi,
D) messagefrom- Sort By > linuc-mips @oss.... 0SS CVS Tree and 2.5.x 2
i Ralf Baechle linux 2.4.5: sysmips(MIPS_... 5 >
S AEleET Bi RalfBacchie Re:stQ doesnotwork, 3 > =?EUC-KR?B?sK29xbHU?= writes:
Properties fin RE: Kernel panic: Attempted t. 5 > > 1am trying to port a linux 2.4 to R3000 based system (LSI LOGIC
Maciej W. Rozycki  Re: linux 2.4.5: sysmips(M... 3 $C2000
Export All Mail Attachments i FlorianLlohoff  Re:linux 2.4.5: sysmips(M... 3 > > )- . L .
Madej W. Rozycki  Re: linux 2.4,5: sysmips(M... 3 > » SC2000 have caches. one is Two-way set associative or direct mapped
TGS i JunSun Re: linux 2.4.5: sysmips(M... 3 > > Instruction cache (16K) and another is Direct-mapped data cache(8K).
ard vhouten Tlegal instruction 2
Refresh Index File >
a... Carsten Langgaard Re: Tlegal instruction 3 o i
Remove File b Houten KH.C. va... Re: Tlegal instruction 2 > [ also spent one or two weeks with Linux on an SC2000 a while ago
Carsten Langgaard Re: Tlegal instruction 2 > but had to stop due to other more important projects. I also ran
06/07/2001 13:14 - Jun Sun Shasim Zhang Re: RTLInux for Mips 2 > into problems with the caching. Without caching I got it to boot
06/07/2001 13:20  Jun Sun i Re: Kernel panic: Attempted t. 2 X . L .
06/07/2001 13:48  Paul Mundt Shaolin zhang Re: RTLinuX for Mips 2 > via NFS. Anyway, atleast one mistake is in this part:
06/07/2001 17:04  Jun Sun Carsten Langgaard Re: Ilegal instruction 12 >
07/07/200107:31 Ralf Bacchle Ashu Joshi Re: Kernel Version Question 3 PN Isi-cachesS
07/07/2001 11:37  Steven 1. Hil linusc-mips Documentation on MIPS kern.. 2 s
07/07/2001 13:51  Keith M Wesolowski Steven J. Hil Re: Documentation on MIPS .. 2 i i i
07/07/2001 1423 Pete Popov sl Re: Documentstion on MIPS .. 3 > > f*void flush_icache(void) */
07/07/2001 18:47  Barry Wu linusc-mips Can mipsel linux supportm... 2 > » LEAF(flush_icache)
08/07/200113:32 JamesSmmons  Pavel Machek Re: [ANNOUNCE] Secondary.. 3 > s set noreorder
09/07/2001 07:02  Pavel Machek James Simmons  Re: [ANNOUNCE] Secondary.. 3
10/07/200106:14  Carsten Langgaard Jun Sun Re: Tlegal nstruction 14 >
10/07/2001 10:57 Ralf Baechle Barry Wu Re: Can mipsel linux suppe... 2 > » la a3, icache_size # 8Kbyte v
< > |« Tt T o - : : - D - : ' ") e kn ﬂ 0(a3)
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To restore hidden windows, left click on the folder to select the folder and then right click on a
143 ld » :
folder and select “Restore Removed Folders” option.
&) mboxview x
File Edit View Help
2| 7|+ k] Al Mails Faund Mails User Selected Mails Help
2% Linux1 N
) apache.mbox Subject: <empty>
{3 attachment.mbox From: <empty>
1) linux-1996-05.eml To: <empty>
() linux-2001-07.eml cc: <empty>
q@ message.eml BCC: <empty>
=} M .
e Show Folder Path Date: <empty>
(= Remove Folder
]
= Refresh Folder
g Restore Removed Files
() nEssage TRt E |
1) message-fram-start-t

Ready

Check files to restore in “Select Files to Restore” dialog.
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| o
| File Edit View Help

=] 7|+ Al Maiks Found Maile User Selected Mails Help
Linux1
N ‘-ih apache.mbox ISubject: <empty =
() attachment.mbax From: <empty>
1) linux-1996-03.eml To: <empty>
{3 linwx-2001-07.eml cC: <empty>
E' message.eml BCC: <empty>
&4 linoc2 Date: <empty>
{3 apache.mbox :
() attachment3.mbax
I inline_attachment.em
{3 linw-1996-05.eml
i) linux-2002-02.eml
1) message-from-start-t
| {3 message-from-start-t
| B Select Files to Restore x

[Tinux-2001-07.eml

Ready

9.8 Hiding of Mail Archive Tree Window

User can hide Mail Archive Tree Window to make larger Mail Summary and Mail Message

Windows. Select button | — or — | to hide/unhide the Tree Window. Tree Window can be hidden only

when one of the mbox mail files is selected.

(B8 mboxview x
File Edit View Help
FIEAEAE I @ Al Mais O Found Mails User Selected Mails Help
-4 Linw1 1| date (Local) + from o subject size(kB) ~
9 apache.mbox 31/12/2010 13:00  shirish RS <shirishag75@gmail....  users@subversion.apache.org newbie subversion questions 7
13 attachment.mbox 04/01/201106:08 René Hiortskoy Nisksen <rene@hjo.,. "Danisl Shahaf” <d.s@daniel.sha...  Re: svnserve with corrupt tmestamps and malfarmed texct representation 8
-3 linux-1996-05.eml 03/01/20110
12 finux-2001-07.eml B 07/12/201109:13 Péter STABADY <Peter.SZABADY... users@subversion.apache.org” <.. merge errar 19
{3 linux-2002-02 eml 16/08/2016 14:54 <webster brent@rogers.com> Subversion Users <users@subvers... My mixed revision working copy remains after a 'svn update' 18
=43 Linux2 16/08/2016 23:49 Ryan Schmidt <subversion-2016@... webster,brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 7
) apache.mbox 18/08/2015 14:33  <webster.brent@rogers.com> Ryan Schmidt <subversion-2016@... Re: My mixed revision working copy remains after a 'swn update’ 21
{33 attachment2.mbox 18/08/2016 14:55 Johan Corveleyn <jcorvel@gmail....  webster.brent@rogers.com Re: My mixed revision working copy remains after a 'svn update’ 10
{75 inline_attachment.em 04/10/2016 15:23 "Rainer Senn” <rainer.. e che.org> R : Feature request for Search function 7
{23 linux-1996-05.eml 05/10/2016 05:03 Torsten Krah <krah.tm ] ch Re: TortoiseSVN RepoBrowser: Feature request for Search function 7
[ linux-2001-07.em 05/10/2016 06:35  Daniel Shahaf <danielsh@apache Rainer Senn <rainer.senn@senn-s... Re: TortoiseSVN RepoBrowser: Feature request for Search function 5
7
7
4
3

1 linux-2002-02.eml 06/10/2016 03:42 Johan Corveleyn <jcorvel@gmai Daniel Shahaf <danielsh@apache.... Re: TortoiseSVN RepoBrowser: Feature request for Search function
e e T 26/07/2017 12:15  Daniel Shahaf ar pache.org... [ANNOUNCE] Apache Subversion 1.10.0-alpha3 released
i T —— 31/10/2017 19:06  Vincent Lefevre sion.apache.org Re: Error E160016 *... is not a directory in flesystem ..."
07/02/2018 08:06  Nico Kadel-Garcia <nkadel@gmail.... Brarko Cibej <brane@apache.org>  Re: svn diff non-temparary files option ©
e . X R i . X s
ISubject: svn: REPORT request failed on ‘/svn/!svn/bc/ooooc
Date: 03/01/201108:13  From: "3J," <zhang.fanwork@qa.com>  To: "users” <users@subversion.apache.org>
~
Hi , all.
Here is my problem:
When I run svn log on my repository which version is 1.6.x with Apache 2.2 on Windows 2003 have suddenly begun getting an error message in their log
windows:
Error REPORT request failed on °/[path_to_repal/!sva/bc/21008° 200 OK (http://[server_namel)
Then I checked the log of apache. get like this
192. 168.0.3 - - [08/Jan/2011:22:00:28 +0800] "OPTIONS /svn HTTP/1.1" 401 401
192. 168.0.3 - zf [09/]Jan/2011:22:00:28 +0800] "OPTIONS /svn HITP/1.1" 200 183
192.168.0.3 - zf [09/Jan/2011:22:00:28 +0800] "PROPFIND /svn HTTP/1.17 207 637
192.168.0.3 - zf [09/]an/2011:22:00:28 +0800] "PROPFIND /svn/!svn/vec/default HITP/1.17 207 392
192.168.0.3 - 2f [09/Jan/2011:22:00:28 +0800] "PROPFIND /svn/!svn/bln/21008 HTTP/1.1” 207 451 v
< > 192. 168.0.3 - zf [09/]Jan/2011:22:00:28 +0800] "PROPFIND /svn HTTP/1.1" 207 637
Ready Mail Retrieval Complete Mail 3 of 17
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9.9 Set MBox Viewer as default application to open mail
archive files
MBox Viewer can be configured as default application to open a mail file by double-left-click on
the file. There are multiple ways to set MBox Viewer as default application. By default, when you
double-left-click on a mail file, Windows will ask user to select program to open the mail file
assuming no application was set as default yet. Make sure the “Always use this app to open ..”
option is set. To redo the current assignment, right-click on the file and select “Open with” option.

9.10 Message Window Position

Message Window position can be set to Bottom, Right or Left via View — Message Window option.
After setting new position, mbox viewer needs to be restarted for the change to take effect.

When position is set to Right or Left, the mail address format will change to show mail name only
or mail address if the name is missing.

By default Message Window position is set to Bottom.

(&8 mbosxview — ] b
File Edit View Help
= 9|7 ® AllMaits O Found Mails User Selected Mals Help
-4 Mails N R N -
f_’ S date (Local) from o subject =08 Isubject: My mixed revision working copy remains after a 'svn update’
&) attachment.mbox SL/L2/2010 13:00 - shirsh 7 users nenbie scbversion auestons 7 Date: 16/06/2016 1454 From: <websterbrent@rogers.com>  To: Subversion Users <users@subversion.
- 04/01/201106:08 René Hiortskov N... Daniel Shahaf ~ Re: svnserve with corrupt... 8
~{ linux-1996-05.eml 09/01/201108:13  ZRFL users svn: REPORT request failed. .. 13
12 linux-2001-07.eml © 07/12/20110:13 Péter STABADY  users@subversi... merge error 19 My mixed revision working copy remains mixed revision after multiple
{2 linux-2002-02.eml 5 5 14:54 _webster.brent __ Subversion Users My mixed revision working ... attempts with 'svn update'.
16/08/2016 23:49  Ryan Schmidt webster.brent Re: My mixed revision work... 7 H;VE ‘o “th:’gina. ctatus ;u: .
18/08/2016 14:33  webster.brent Ryan Schmidt Re: My mixed revision work... 21 - . - R
18/08/2016 14:55 Johan Corveleyn  websterbrent  Re: My mixed revision work... 10
04/10/2016 15:23  Rainer Semn users TortoiseSVN RepoBrowser: ... 7 Limux] s> svm st -u
05/10/2016 05:03 Torsten Krah users Re: TortoiseSVN RepoBrows... 7 x - vobs/ Gommon/ GpComman
05/10/201506:35 Danelshshaf  Rainer Senn Re: TortoiseSVN RepoBrons... 5 X vobs/ commanyde1Common
06/10/201503:42 JohanCorveleyn  DamelShahaf  Re: TortoiseSVN Repodraws... 7 x vobs/ots/broadcom/BCH_SDE_6.4.11
26/07/2017 12:15 Danelshahaf  announce [ANNOLINCE] Apache Subver.. 7 x
31/10/2017 19:06 Vincentlefevre  users Re: Error 160016 ™., s not.. 4 vobs/ots/osne/Apps /HalServer/Drivers/1ime00/Lind 00APT
07/02/201808:06  Mico Kadel-Garcia  Branko Cibej Re: svn diff non-temporary ... & X vobs/ots/osmé/Target/PldImages/1im400g_1
10/02/2018 02:59  Thorsten Schiining  users Does svn dientbinary ha... & i "”ia’ ”EE’* ”E“q’t EE” ?NDD‘;G;’E" tliprobe/mteraiv
vobs/ots/uboot/u-boot— .
19/02/2016 08:40  Ignaci Gonzdlez ... users Not sa cheap maves 8 % A A
/ots) /u-boot- o1,
x vobs/ots/urlplat/tlab_gemuppe
X vobs/ots/urlplat/tlab_xeoncors50
X vobs/ots/urlplat/tlabgorigs0_small
x vobs/prod
Status against revision: 13673
Performing status 1 item at
'vobs/ots/osmé/Ta =/1imd00g_1:
Status against revisio 746
Performing status on external item at 'vobs/ots/uboot/u-boot-2009.06":
Status against revision: 475
Performing status on external item at 'vobs/common/cpCommon':
Status against revisio 101
Performing status on external item at 'vobs/common/dclCommon':
Status against revision: 101
Performing status on external item at 'vobs/ots/uboot/u-boot-2013.01.01': “
Status against revision: 475
< >
Ready Mail Retrieval Complete  Mail 5 of 17

9.11 Preservation of Windows Placement

Mbox Viewer will save the windows placement upon exit and restore upon next run.

9.12 Background Color Style Customization

By default the background color of all display panes is set to the white color. Select the
“File — Color Style Config” menu option to customize colors of display panes. Left click on the
Custom button to start customization. The screen similar to the below will be created.
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) mboxview - X
File Edit View Help
=0 ‘ 9 ‘ User Selected Mals

31/12/2010 shirsh e
04/01/2011 é

16/08/2016 14:54 webster.brent  Subversion Users.
16/08/2016 23:49 Ryanschmidt  webster.brent

18/06/2016 14:33 websterbrent  Ryan Schmidt

18/08/2016 14:55 Johan Corveleyn

04/10/2016 15:23 Rainer Sern wsers

05/10/2016 05:03 Torstenkrah wsers

05/10/2016 06:35 Dariel Shahaf  Rainer Semn Re: TortoiseSVN RepoBrows.
06/10/201603:42 Johan Corveleyn  Dariel Shahaf  Re: TortoiseSVRepoBrows...
26/07/2017 12:15 Dariel shahaf  announce [ANNOUNCE] Apache Subver.
31/10/2017 13:06 VincentLefeve  users Re: Error E160016 *...isnot,
07/02/2018 08:06 Nico Kadel-Garcia  Branko Cbej Re: svn diff non-temporary.
10/02/201802:59  Thorsten Schoring  users. Does svn dient binary ho,

Color Style Configuration

Badaround Colorstykes
Opefait @ custom
preconfigured

0z O3 04 Os Os O7 Os

@oasNNnNNEpg e

Ready Mail Retrieval Complete __ Mail 4 of 17

Color Style Configuration dialog allows users to replace the white background of the 8 panes listed
on the dialog box with the predefined colors or custom colors defined by users.

The dialog offers eight predefined color styles users can evaluate before attempting to configure the
custom color style. It is helpful to open one of the mails with attachments to help to evaluate
predefined and custom color styles.

Select "Custom" radio button to start configuration of the custom color style.
Configure the same or different color for each pane (MailArchiveTree, etc).

Select one of the panes and left click on the "Pick Color" button to start the "Color Selection
Dialog".
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Color Style Configuration
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The "Pick Color" button will initially be populated with the color associated with the selected pane.

The top raw of the Custom Colors area will initially be populated with the colors associated with
each pane.

You can change the color in four different areas. The top left section displays a list of 48 predefined
colors.

If the desired color is not in that section, you can click on the crosshair and drag the mouse in the
multi-colored palette.

You can also drag the right bar that displays a range based on the color of the palette.

For more precision, you can type the Red, Green and Blue values in the custom color editor area.
Each uses an integral value that ranges from 1 to 255.

Once you are happy with the custom color, left click on the OK button in

the "Color Selection Dialog". The "Color Selection Dialog" will be closed and control will return to
the "Color Style Configuration" dialog.

The "Pick Color" button will be painted with the created custom color. Left click on the "Apply"
button to apply the new color to the selected pane. Left click on the "Apply" button again to cancel
the change.

Left click on the Save button to save the change in order for the change to persist after the mbox
viewer shutdown. Or, customize colors of all panes first and then left click on the Save button to
save all changes.

Left click on the Cancel button to discard all changes made since the last Save or startup.
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Left click on the Close button or standard Windows Close button to hide the "Color Selection
Dialog". Changes made so far are not discarded.

To reopen, select File -> Color Style Config menu option.

NOTE that the saved color style will be applied to all mails. You can temporarily disable custom
color style for the active mail by right click on the mail header in the mail message window and
selecting Enable/Disable Custom Color Style menu option.

B mboxview - x
Fle Edit View Help

© 4 Mails O Found Mails User Selected Mais

31/12/2010 13:00  shirish TS ’7
04/01/2011 06:08 é - Clear Find Text

09/01/2011 08:43 3. 3 Enable/Disable Custom Color Style

16/08/2016 14:54 webster.brent  Subversion Users.
16/08/2016 23:49 RyanSchmidt  webster brent

18/08/2016 14:33 websterbrent  RyanSchmidt  Re: My mixed revision work.
18/08/2016 14:55 Johan Corveleyn  webster.brent  Re: My mixed revision work.
04/10/2016 15:23 Rainer Sern wsers. TortoiseSVN RepoBromser: ..
05/10/2016 05:03 Torstenkrah wsers Re: TortoiseSVN Reporows.
05/10/2016 06:35  Dariel Shahaf Re: TortoiseSVN Reporows.

Rainer Semn
06/10/201603:42 Johan Corveleyn  Dariel Shahaf  Re: TortoiseSVN RepoBrows.

26/07/2017 12:15 Dariel Shahaf  announce [ANNOUNCE] Apache Subver..
31/10/2017 13:06 VincentLefeve  users Re: Error E160016 *...isnot,
07/02/2018 08:06  Nico Kadel-Garcia  Branko Cbe] Re: svn diff non-temporary.
10/02/2018 0259 Thorsten Schoning  users. Does svn dlentbinary ho,
19/02/2018 08:40  Ignacio Gonzalez .. users Mot so cheap moves:

@@ e NN NN [

lete  Maild of 17

9.13 Support for Gmail Labels

User can perform a separate step to recreate Gmail Labels on Gmail mbox mail archives. Gmail
Label information is included in every email downloaded from Gmail. To recreate labels, user needs
to right click on an active Gmail mail archive in Tree Pane and select “Gmail Labels — Create”
option. This will create folders as in example below. Left click on the folder icon to view all mails
within the label.

293 Mail

== All mail Including Spam and Trash.mbox
- Inbox
-l Sent

- Archived
- Category
- Drafts
- Important
- Opened
- M Osobiste
- Starred
» Unread

Select the folder icon to view all mails again. Button “All Mails and ‘Found Mails” are scoped to
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the label when a label is selected. Content of “User Selected Mails” is shared across all labels of the
active folder and the folder.

9.13.1 Limitations

If you decide to hide/remove the folder from the Tree Pane Via “Remove File” option and later
restore via “Restore Removed Files” option, Gmail labels will not be automatically restored until
you recreate the labels.
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9.14 Expand Message Header Field List

When message window position is configured at the bottom, the message header list doesn’t show

CC and BCC message header fields. This can be changed via “View —> Message Header Pane

Layout —>Expanded” option.

9.15 Viewing raw message header

The raw message headers can be viewed in the message window by setting “View — View Raw
Message Headers” option. This is the global change and it needs to be disabled to view messages
content again. The raw message header can be viewed by doing the right click on the message

header pane and setting “View Raw Header” option. The setting doesn’t persists when new mail is

selected.

9.16 HTML/PDF Mail Header Customization

The HTML/PDF Header Configuration dialog allows users to select mail header fields for output

and to configure fonts for the field name and field text. User can also configure to output the list of
all attachments. The customization dialog is selected via “File” --> “Print Config” --> “HTML/PDF

Header Configuration” button.
There are two options to configure fonts: Default and Custom.
The Default option allows to configure:
1. the font size which be applied to both the field name and text.
2. the bold font style which will be applied to the field names only.
The Custom option allows to configure:
1. the same or different font for the header field names and text.

2. the font dialog allows to configure the font name, style and size.

3. the generic family font in addition to the primary font configured via the font dialog.

The following links contain helpful information on HTML fonts.

HTML Fonts
Fonts and Formatting
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https://www.granneman.com/webdev/coding/css/fonts-and-formatting
https://www.w3.org/TR/css-fonts-3/#font-matching-algorithm
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File Edit View Help
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@] 7|+ © AllMaik O Found Mals O User Selested Mails Help

S | date (Local) 4 to wbject sz2(®)
{0 Linuxt 06/07/2001 17:04 Jun Sun <jsun @mvista.com: Carsten -
{3 MailTkout!

ere s the new president of Arg

BHDBBE 2 <

Font Configuration

Subject: Re: lllegal instruction
Date: 06/07/2001 17:04  From: Jun Sun <jsun@muista.com>

@ Default O Custom Hr Field Font.

[soid Field Name

e

| fo-fast-sysmips.0105K X patch || MIPS_ATOMIC_SET-compromising-fix.0 10626010626 pathc
>

<
Ready

User can also configure how to open document/attachment link in Web browser.

9.17 Single Mail Context Menu

Right Click on a selected mail in the Summary Window to open the context menu as shown below.

The “Print to” context menu allows to print the selected mail to Text, HTML or PDF file or to send
to the user selected PDF printer.

The “Open in Browser” menu option will open the selected mail in the external default Web
Browser.

The “Find Text” option allows to find user specified text and highlight all occurrences in the
Message window.

The “Find Advanced” options will start the advanced search dialog and pre-populate From, To and
Subject fields from the mail.
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(& mboxview - m] x
File Edit View Help

= 3|7 ® All Mails (O Find Mails User Selected Mails Help

=44 Mails | date(loca)t  from 1o subject size(KE)

-2 apache.mbox 04/01/201106:08 René_Hjortskov_Nielsen <rene@h... "Daniel Shahaf” <d.s@daniel.sha...  Re: svnserve with corrupt tmestamps and malformed text representation 5

0 attachment.mbox = 05/11/2017 22:42 americanairines @aa.com John.Smith@gmail.com 4
3 linux-1996-05.eml Print To >

{23 linux-2001-07.eml

{23 linux-2002-02.eml Print Related Mails To >

Open in Browser

Open Related Mails in Browser

Open Related Files Location

Find Text
ISubject: (/0) American Airlines Boarding Pass(es).

Date: (Windows-1252/1252) 05/11/2017 22:42  From: (/0) americanairl lines@aa.com  To: (/0] (el d 1)
. T -
AmericanAirlines "¢
Reservations | ASdvantage Accourt | Fare Sales & Offers
You must print all attached boarding pass(es) before proceeding to the airport. This is not a valid mobile boarding
pass.
Gate and terminal may change. Check airpert monitors when you arrive or visit flight status
Thank you for choesing American Airlines.
Americanirlines Wy
s AAdvantage ¢
Unsubscribe  Change your emal address  Wpdata vour email preferences  Privacy Polic
r BYIGVM.pdf
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9.17.1 File Names

User can configure file name pattern/template to apply when printing single mail by selecting File -
> Print Config dialog. Pattern is composed from Date, Time, From, To, Subject and Unique Id
fields. Only alpha numeric characters are selected from the Subject, other characters will be
replaced with the underscore.

Files will be saved in the FolderHousingMail Archives/PrintCache/MailArchiveName folder, where
MailArchiveName denotes the archive file name without the .mbox extension.

User must enter the target file name manually when printing to PDF printer, i.e. when selecting
Print to — Printer mail option or when printing mail to pdf file from the browser.

Print Config dialog allows users to configure the maximum length of created file name. The
maximum file path length supported by Windows is 260 characters for non Unicode applications.
Therefore the file name will be limited to (260 — length of

FolderHousingMail Archives/PrintCache/Mail ArchiveName/MailFileName) path. User can set
wanted file name length limit and the mbox viewer will adjust the configured length if needed.

9.18 Multiple Selected Mails Context Menu

Multiple mails can be selected using Windows standard method, i.e. Left click followed by
Shift+LeftClick or CTRL+LeftClick or CTRL+A.

Right Click on a multiple selected email in the Summary Window to open the context menu as
shown below.

The “Print Selected Mails to” context menu option allows to print the selected mails to single Text
or HTML or CSV or PDF files or send to the user selected PDF printer. See also 9.32.7 “Mail
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Printing to PDF files by Power Users” section.

The “Open Selected Mails in Browser” menu option will open the selected mails in the external
default Web Browser.

(&) mboxview - m] x
File Edit View Help

= 1|7 ® Al Mails O Find Maiks User Selected Mals Help

-4 Mails | date(ocalt  from o subject sizekE)

{3 apache.mbox
- D DN R = (05/11/2017 22:42 _americanairines @aa.com John.Smith@gmail.com American Arrlines Boarding Pass(es). Print Selected Mails To >

£ linux-1996-05.eml Tet..

1 linuz-2001-07.eml Open Selected Mails in Browser HTML.
() linux-2002-02.eml

04/01/201106:08 René_Hiortskov_Nieken <rene@h... "Daniel Shahaf® <d.s@daniel.sha... Re: svnserve with corrupt tmestamps and

Printer...

PDF..

CSV..

ISubj:r:t: (f0) American Airlines Boarding Pass(es).
Date: (Windows-1252/1252) 05/11/2017 22:42 From: (/0) americanairlines@aa.com To:(/0) John.Smith@gmail.com Body: (UTF-2/65001)

American Airlines\\ @

Reservations | Afdvantage Accourt | Fare Sales & Offers
You must print all attached boarding pass(es) before proceeding to the airport. This is not a valid mobile bearding

Gate and terminal may change. Check airpert menitors when you arrive or visit flight status

Thank you for choesing American Airlines

AmericanAirlines \
F@ AAdvantage ‘g

Unsubseribe  Change your email address  Update your email prefersnces  Privacy Poicy

r BYIGUM.pdf
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9.18.1 File Names

User can’t configure file name pattern/template to apply when printing multiple mails to a single
file. The file name is automatically composed from the archive file name with appropriate
extension, i.e. .txt or .htm or .csv or .pdf.

Files will be saved in the FolderHousingMailArchives/PrintCache/MailArchiveName folder, where
MailArchiveName denotes the archive file name without the mbox extension.

User must enter the target file name manually when printing to PDF printer, i.e. when selecting
Print Selected mails to — Printer mail option or when printing mail to PDF file from the browser.

9.19 Conversation Mail Group Context Menu

All Mails must be sorted by the conversation first before context options can be processed. See 9.26
section.

Right Click on any mail within the selected conversation group in the Summary Window to open
the context menu as shown in 9.17 section.

The “Print Related Mails to” context menu option allows to print the selected group of mails
(conversation) to Text, HTML, CSV or PDF file or to send to the user selected PDF printer.

The “Open Related Mails in Browser” menu option will open the selected mail group in the external
default Web Browser.
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9.19.1 File Names
See 9.18.1 section.

9.20 Mail Archive Context menu

Right click on the active mail archive under the Mail Archive Tree Window to open the context
menu as shown below.

@ mboxview — O b3
File Edit View Help
= 57| (® Al Mails (O Find Mails User Gelected Mais Help
=83 Mails date floca) 1| from o subject size(kE)
-2 apache.mbox 04/01/201106:08 René_Hjortskov_Nielsen <rene@hjortsk... “Daniel Shahaf” <d.s@daniel.shahaf.name > Re: sunserve with corrupt timestamps and malformed text representation 8
Q o John, Smith@gmail, com American Airlines Boarding Pass(es).
2 linux-1996-05 Brint To N

1) linux-2001-07
{2 linue-2002-02 Sort By >

Open File Location

Properties

Refresh Index File

ISubjer:t: American Airlines Boarding Pass(es).
Date: 05/11/2017 22:42  From: americanairlines@aa.com  To: John.Smith@gmail.com

AmericanAirlines \\ @

Reservetions | Addvartage Accourt | Fare Sales & Offers
You must print all attached boarding pass(es) before proceeding to the airport. This is not a valid mobile bearding
pass.

Gate and ferminal may change. Check airpert monitors when you arive or visit fight status
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f@ AAdvantage ‘g

IQ BYIGVM. pdf
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The context menu allows to print all email to single CSV, Text , HTML and PDF files. The name of
the created file will be created based on the archive file name with the .csv or .txt or .html or .pdf
suffix in the FolderHousingMail Archives/PrintCache/Mail ArchiveName folder, where
MailArchiveName denotes the archive file name without the mbox extension. NOTE that mails will
be printed according to the sort order in the summary window.

Size of HTML file can be very large and opening in most of the browsers can be problematic.
Microsoft Edge and Google Chrome browser seem to perform best as far as handling large HTML
files.

When printing to TEXT file, HTML to Text conversion was added in 1.0.2.8 to handle mails with
HTML text block and no Plain text. Conversion can be quite slow and print time could increase
significantly compared to 1.0.2.7 in case the large number of conversions is required. Progress bar
was added to indicate progress, possibly slow progress.

Printing to single PDF file is the most time consuming. See also 9.32.7 “Mail Printing to PDF files
by Power Users” sections for larger scale printing to single PDF file.
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All mails of the active archive can be sorted by date, from, to subject, size and conversations in the
Summary Window. This feature is the same as the left click on the selected column in the Summary
Window.

The “Properties” option shows the archive file location, size and email count

The “Refresh Index File” option will perform fresh parse of the archive file if needed.

9.20.1 Print to CSV File Dialog

When printing selected mail archive or selected set of mails by a user to CSV file, user can select
what fields to export, the date format and one of two time zones.

Option to normalize content encoding is also available. Default encoding is set to UTF-8 and should
not be changed except possibly in special cases.

The “Limit Message to N Characters” value is set by default to 32500 characters and it should not
be set higher otherwise Excel and LibreOffice will complain that the character count limit per
spreadsheet cell was exceeded. LibreOffice will gracefully handle the text overflow, Excel
spreadsheet will get corrupted.

User can configure string that separates attachment names. The special CRLF string will be
replaced with \r\n string in the CSV output.

Select Fields to Export To C5V File =

Date To From subject [Jcc []BCC

[[] attachment Mames Separator | CRLF

|:| Message Limit Message to M Lines I:I
Limit Message to N Characters | 32500

Encoding:  (Onone (@ UTFS
(O User Defined Code Page Id: | 65001

Open "View" menu to view All Code Page Ids

Date format: () dd/mm/yyyy

O mmfdd/yyyy
O yyyy/fmm/dd
Tme: ®local (JGMT

Cancel

9.21 Mail Attachments

Mail attachments are shown at the bottom of the Message window. Note that the “*’ character may
appear in the first column for the associated mail to indicate presence of associated attachments. To
open location of attachments, double click on the mail in the Summary window or select

“View” - ”ViewEML” menu option. Temporary folder will open containing all attachments for the
email. Use standard Windows applications to view attachments.

You can also double left click to view attachments. Picture attachments will be viewed in the
Picture Viewer (if configured in the global Options) and other file types will be viewed by the
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associated default Windows applications.
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9.21.1 Attachment context menu

Right click on the selected attachment to open the context menu. The context menu allows to open
or print the attachment by the associated default application. You can also open the folder housing
the attachment. The selected attachment will be highlighted in the folder.

(&) mboxview - m] x
File Edit View Help

=17 (@ 2Nl Mails O Find Mails User Selected Mails Help

-4 Mails date (Loa) 1 from o subject sizelkE)

{2 apache.mbox

) attachment.mbox
{3 linux-1996-05.eml

£ linusx-2001-07.eml
{5 linux-2002-02.eml

tamps and malformed text representation 3

04/01/201106:08 _ René_Hjortskov_Nielsen <rene@hjortsk... "Daniel Shahaf™ <d.s@daniel.shahaf.name > Re: svnserve with corrupt i
= 05/11/201: americanairin John. Smith @gmail com American Airines B

ISubjcct: American Airlines Boarding Pass(es).
Date: 03/11/2017 2242 From: ameri om To: John. om

American Airlines\g @

Reservations | Addvantage Accourt | Fare Ssles & Offers
You must print all attached boarding passies) before proceeding to the airport. This is not a valid mobile boarding
pass.

Gate and terminal may change. Check airpert menitors when you arrive or visit flight status

Thank you for choesing American Airlines.

American Airfines \
peee] AAdvantage ¢

Unsubseribe  Change your email address  Update your email preferences  Privacy Pofiey

Open

Ready B Print Mail Retrieval Complete  Mail 2 of 2

Open File Location
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9.21.2 Attachments Configuration

The “Attachment Config” dialog enables users to configure attachment window size, content and
attachment indicator criteria. Users can also configure whether image attachments should be
appended to mails when showing and/or printing.

Select “File — Attachment Config” to access the dialog.

Attachments Config *

Attachment Window

Max Size in % of Message Window

By default attachments other than those embeded into mail message are shown in the attachment window
Show Al Attachments

NOTE that "Show All Attachments™ will affect output from Print To, View in Browser and Export All Mail
Attachmensts options

Mail Attachment Indicator

By default the attachment indicator is set when the mail has at least ane
attachment marked as Attachment Type

Set when any attachment present

Append Picture Attachments to Mail View Append Picture Attachmenst to Mail Print
Single Mail Multiple Selected Mails Single Mail Multiple Selected Mails
Cancel

9.21.3 Exporting All Attachments of All Mails

User can export all attachments to the AttachmentCache folder by right clicking on the active mail
archive and selecting “Export All Mail Attachments” option. To avoid appendix name clashes,
Mbox Viewer will prepend the following prefix to each attachment name:

YYYYMMDD-HHMMSS-IDDDDDD attachment name

where YYYY denotes the year, MM denotes the month, DD denotes day, HH denotes hour, MM
denotes minues, SS denotes second of a mail abd IDDDDDD denotes unique ID assign to this
email.

9.22 Inline Image Cache

The mboxview will create the cache of inline images to support images embedded directly into the
mail body/message. The cache with all images can be created during the initial parsing of the mail
archive file or subset of images can be created later when needed. Separate cache sub-folder is
created per each archive file (assuming at least one inline image was found) in the
FolderHousingMail Archives/ImageCache folder. If the inline image cache is missing for any
reason, try to refresh the index file by selecting “Refresh Index File” context option on the
respective file archive.
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9.23 Export of all Mails to a Separate Eml files

User can export all mails to separate Eml files via mail archive context menu. Right click on the
selected mail archive and select “Export All Mails as Eml” option. Eml files will created in the
FolderHousing AllMail Archives/EmlCache/SlectedMail ArchiveName folder.

Mbox Viewer will create Eml file names as follow:

YYYYMMDD-HHMMSS-IDDDDDD name using File Name Configuration under File —> Print
Config dialog.

where YYYY denotes the year, MM denotes the month, DD denotes day, HH denotes hour, MM
denotes minues, SS denotes second of a mail abd IDDDDDD denotes unique ID assign to this
email.
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9.24 Picture Viewer

Double left Click on any attachment to start Picture Viewer dialog, example below.

& niagara.jfif — O X

The Picture Viewer supports files with the png, jpg, pipg, jpeg, pjpeg, jpe, gif, bmp, ico, tif, tiff, jfif,
emf, wmf, dib suffixes.

The NEXT and PREV controls enable user to browse all picture/image attachments associated with
the selected email. You can select specific attachment to be displayed. You can later browse through
all picture attachments.

The ROTATE control allow to rotate clockwise the current/visible picture.

The ZOOM control allows to zoom in/out picture. Click on ZOOM to enable/disable zooming.
Slide to right to enlarge an image, slide to left to shrink. Enlarged image can be dragged using the
left and scroll buttons of the mouse. Click ZOOM to disable zooming and reset the image to
original size.

The PRINT control allow to print via default application.

The Picture Viewer is enabled by default but it can be disabled via FILE — Options dialog. Setting
persists in the Registry across multiple runs.
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All attachments are also accessible by double clicking on the selected mail in the Summary window
or by selecting “View” - ”ViewEML” menu option.

9.25 Mail Navigation

Click on a specific mail in the Summary window and use UP, DOWN keys to move to the next or
previous mail respectively.

Use HOME key to jump to the first mail. Use END key to jump to the last mail.

Use the mouse wheel or vertical bar to scroll up and down mails and then select one of the mails.

9.26 Mail Sorting

The Summary window is divided into 6 columns: attachment indicator, date, from, to, subject and
mail size. Each column can be sorted by clicking on the column title. Subsequent click on the same
column title will reverse the sorting rule. By clicking on the first column title, emails are sorted by
conversations and mark by different color as shown below.

Mail can also be sorted via the mail archive context menu or by selecting “File”->“Sort By” menu
option.

() mboxview - ] x
File Edit View Help
= %] 7] ® All Mails O Found Mails User Selected Mails Help
=44 Mails 14| date (Local) fram to subject size(®) | °
- (@b apache. mbox 31/12/2010 13:00  shirish RIS <shirishag7S@gmail...  users@subversion.apache.org newbie subversion questions 7
-2 a_m‘hme"t‘”"b” 04/01/201106:08 René Hiortskov Nielsen <rene@hj... “Daniel Shehaf™ <d.s@daniel.sha... Re: sunserve with corrupt timestamps and malformed text representation 8
12 linuse-1896-05.eml 03/01/201108:13 "3k <zhang.fan.work@qg.com>  “Users” <users@subversion.apac...  svn: REPORT request failed on 'fsvn/isvnjbefooood 13
1 linux-2001-07.eml 8 07/12/201109:13 Péter S7ABADY <Peter.SZABAD... "users@subversion.apache.org”... _merge error 19

{2 linux-2002-02.eml 5) 5 14:54 _<webster,brent@rogers.com> Subversion Users <users@subver... My mixed revision working copy remains after a 'svn update’

16/08/2016 23:49  Ryan Schmidt <subversion-2016...  webster. brent@rogers.com Re: My mixed revision warking copy remains after a ‘svn update’ 7

18/08/2016 14:33  <webster brent@rogers.com> Ryan Schmidt <subversion-2016...  Re: My mixed revision working copy remains after = 'svn update’ 21

18/08/2016 14:55 Johan Carveleyn <jcorvel@gmail...  webster. brent@rogers.com Re: My mixed revision warking copy remains after a ‘svn update’ 10

04/10/2016 15:23 "Rainer Senn” <rainer.senn@senn. .. .apache.org>  TortoiseSYN RepoBrowser: Feature request for Search function 7

05/10/2016 05:03  Torsten Krah <krah. tm@gmai.com> sion.apache.arg Re: TortoiseSVN RepoBrowser: Feature request for Search function 7 =

ISubjer:t: My mixed revision working copy remains after a 'svn update’

Date: 16/08/2016 1454 From: <webster.brent@rogers.com> To: Subversion Users <users@subversion.apache.org>

My mixed revislon working copy remains mixed revision after multiple attempts with 'swn update'.
Here's the final status output:

[linux] »>> svn st -u
voks/ common/ cpCommon
voks/common/delCommon
vobs/ots/broadcom/BCM_SDK_6.4.11
vobs/ots/osmé/Apps/HalServer/Drivers/1im400/Lim400APT
vobs/ots/osmé/Target/PldImages/1imé00g_1
vobs/ots/osmé/Tests/framework/tllprobe/nteraiv
voks/ots/uboot/u-boot-2008.06
vobs/ots/uboot/u-boot-2013.01.01
vobs/ots/wrlplat/tlab_gemuppc
vobs/ots/wrlplat/tlab_xeoncore50
vobs/ots/wrlplat/tlabgorigs0_small
vobs/prod -

tatus against revision: 13673

R R

Performing status o
Status against revisio

21 item at 'vobs/ots/osmé/Target/PldImages/1imé00g 1':
7462

Performing status on external item at 'vobs/ots/uboot/u-boot-2009.06':
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9.26.1.1 Subject Sorting Rules

Subject sorting creates subject threads, that is a group of mails (or threads) with the same subject.
Emails within a thread are sorted by time.

By default the subject threads are sorted alphanumerically.

Subject threads can sorted by time by selecting “File- — Options — time ordered threads” option.
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9.27 Dynamic Column Resize

Columns in the Summary windows are automatically resized when the window is resized.

However, if columns are resized manually, some of the columns may no longer be present in visible
area/window.

You may need to use the scroll bar to see missing columns, otherwise maximize and then restore the
window to see all columns within the Summary window again.

9.28 Mail Searching

Mbox viewer supports two search options, i.e. basic Find and Advanced Find.

The basic Find option allows users to specify single keyword for searching across header fields,
mail text, attachment text and attachment names.

The advanced Find option allows user to specify keyword per each header field, mail text,
attachment names and attachments.

9.28.1 Basic Find

The basic Find option allows users to specify single keyword/string for searching across header
fields, mail text and attachments.

Users can configure the search scope by selecting all or subset of the from, to, subject, message
text, attachment names and attachment text options. The search succeeds if the specified keyword
matches any of the checked fields.

Click the “Edit” drop menu and select “Find” option to configure and start the search. Alternatively
the CTRL+F will also present the search dialog.

The search dialog box allows user to specify the search string, whether to match the whole word,
whether the search is case sensitive, configure the search scope, the start and end dates to consider
for filtering, the Next/Previous search direction and whether to highlight all occurrences of the
matched text.

Note that the Next search start with the oldest email while the Previous search starts with the latest.

The search logic simple, i.e. mail is considered a match if the search string is found in any of the
checked fields in that mail.

34



Find =

Find what [ | & ]

[whale word  [[] Caze senzitive

[] Highlight all occurences in Message

Cancel

Search scope
Fram Ta Subject [JMessage [JCC [JBCC
[ attachment Text  [] Attachment Mame

[] Filter dates:

To zet new dates. open calendar by zelecting down arrow, or

Left click an month, day or pear field and type new value

start date: [10/27/2011 |

end date: | 2/20/2019 |

[]Find all occurences [ Find mailz that don't match

Search Direction

() previous (@) nent

To repeat the search in order to find the next matching mail, click the “Edit” drop menu and select
“Find again” option, or select F3 key.

If “Find again” or F3 key is selected without prior “Find” or CTRL+F, the search dialog box will
be presented to a user.

9.28.1.1 Find All Occurrences Option

User can check “Find all occurrences” to find all matching mails. Automatic highlighting of all
keyword occurrences is not supported in this case. Matched mails will be displayed under the Found

Mails List and the corresponding button in the dialog bar will be highlighted. User can left click on
All Mails button to switch mail list back to All Mails.

The basic Find can also be run while in the Found Mails list and while in User Selected Mails list
when the list is enabled.

Find =

Find what |mac\ei | |

[J'whole word  [] Case sensitive
[ Highlight all occurences in Message
Search scope
From Ta Subject [JMessage [JCC [JBCC

[ attachment Text  [] Attachment M ame

[CIFilter dates:
To set new dates, open calendar by selecting down arraw, or

Left click on month. day or year field and type new value

start date: 1042772011
end date: 242042019

Find all accurences [ Find mails that dan't match

Search Direction
previous (®) next

9.28.1.2 Find mails that don’t match option

User can check “Find mails that don’t match” option to find mails that don’t match search criteria.
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9.28.1.3 Handling of special ‘**' search string

User can specify single ‘*’ character as the search string to find subset of mails as follows:
1. Find mails that have CC header field by checking out CC check box only.
2. Find mails that have BCC header field by checking only BCC check box only.

3. Find mails that have at least one attachment by checking out Attachment Name check box
only.

4. Match all mails by checking out any of others check boxes only.

NOTE that if the Find all occurrences option is not selected, user will be traversing the subset of
mails/matched mails between the start and end dates.

() mboxview - ] x
File Edit View Help
= %] 7] () &l Mails ®) Find Mals User Selected Mals Help
-4 Mails | dateQocal)t | from to subject sefE) | *
~{3 apache.mbox 02/07/2001 10:06 _"Maciej W. Rozycki® <macro@ds2.pg.od... Harald Koerfgen <Harald.Koerfgen@home. . linux 2.4,5: A DECstation HALT interrupt handler 5
= a_m‘hme"t‘”"b” 02/07/2001 11:05 Ralf Baechle <ralf@oss.sgi.com> "Maciej W. Rozycki® <macro@ds2.pg.ad... Re: linux 2.4.5: A DECstation HALT interrupt handler 2
12 linux-1996-05.eml 05/07/200106:14 “Maciej W. Rozycki® <macro@ds2.pg.gd... Ralf Baechle <ralf@unikoblenz.de> linux 2.4,5: sysmips{MIPS_ATOMIC_SET) is broken (yep, again...) 5
~{3 linux-2001-07.eml 05/07/200106:35 “Maciej W. Rozyck® <macro@ds2.pg.gd... Ralf Baechle <ralf@oss.sgi.com> Re: sti() does not work. 3
-1 linux-2002-02.eml 05/07/200109:27  Florian Lohoff <flo@rfcs22.0rg> “Maciej W. Rozycki® <macro@ds2.pg.qd... Re: linux 2.4.5: sysmips(MIPS_ATQMIC_SET) is broken (yep, again...) 3
05/07/2001 10:08 “Macie] W. Rozycki” <macro@ds2.pg.gd...  Florian Lohoff <fo@rfca22.0rg> Re: inux 2.4,5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...) 3
05/07/2001 12:51  Jun Sun <jsun@mvista.com> "Madie] W. Rozyck” <macro@ds2.pg.qd...  Re: linux 2.4.5: sysmip _ATOMIC_SET) is braken (yep, again...) 3
05/07/2001 13:23  “Maciej W. Rozycki” <macro@ds2.pg.gd...  Jun Sun <jsun@mvista, com> Re: linux 2.4,5: sysmips(MIPS_ATOMIC_SET) is broken (yep, again...) 3
06/07/200106:42 "Maciej W, Rozyck” <macro@cs2.pg.gd... "Houten K.H.C. van (Karel)" <vhouten...  Re: Tlegal instruction 2
12/07/200107:05 “Maciej W. Rozycki” <macro@ds2.pg.od... Karsten Merker alibur.col...  Re: gom-support for serial DECstation mouse (VSXXX-AA) & =
ISubjer:t: (/0) linux 2.4.5: A DECstation HALT interrupt handler
Date: (Windows-1252/1252) 02/07/2001 10:06 From: (/0) "Maciej W. Rozycki* <macro@ds2.pg.gda.pl> To: (/0) Harald Koerfgen <Harald Koerfgen@home.ivm.de>, Ralf Baechle <ralf@uni-koblenz.de>
Hi, A
Following is a minimal implementation of a HALT interrupt handler for
DECstations. The handler resets a system (invokes a warm restart) afrer
the HALT butten or, in case of the MAXINE, the HALT sequence of keys is
pressed. The patch should be OK to apply.
Macied
+ Macisj W. Rozycki, Technical University of Gdansk, Foland +
+ e-mail: macro@ds2.pg.gda.pl, PGP key available +
patch-mips-2.4.5-20010627-halt-basic-0
diff -up --recursive --new-file linux-mips-2.4.5-20010627.mscro/arch/mips/dec/int-handler.S linuz-mips-2.4.5-20010627/arch/mips/dec/int-handler.s
L i 0010627 .macro/arch/mips/dec/int-handler.5 Thu Jun 14 04:26:19 2001
20010627/arch/mips/dec/int-handler.S Sun Jul 1 00:24:21 2001
ee @ spurious:
dec_intr fpu: PANIC("Unimplemented FPU interrupt handlexr")
I
- # Halt interrupt v
iy
< >
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9.28.2 Advanced Find

The advanced Find option allows user to specify different keyword per each header field, mail text,
attachment name and attachments.

Users can configure the search scope by selecting all or subset of the from, to, subject, cc, bcc,
message text, attachment name and text attachments options.

Click the “Edit” drop menu and select “Find Advanced” option to configure and start the search.

The Find Advanced is also available as menu option for the selected mail. Right click on the mail
and select Find Advanced option. Mbox Viewer will pre-populate From, To and Subject fields in
this case.

36



Find Advanced X
Select filter fields
Find what Match word  Match case
[<IFrom ‘ shirishag75@gmail.com ‘ O O
e ‘ users@subversion apache.org ‘ O O
Subject ‘ newbie subversion questions ‘ O O
Oec [ (= ]
Oecc [ = O
[IMessage ‘ ‘ O O
[ attachment ‘ ‘ O O
Text
[ attachment ‘ ‘ O O
.

Reset All [Jsetall [Jsetal
[JFind all mails that don't match [[IMatch TO field only if single recipient on the list
Configure Filter Rule Rule 1is selected 111

{{From <~> To) and CC and BEC and Subject and (Message Text or Attachment Text) and Attachment Name

[ fiter dates:

To set new dates, open calendar by selecting down arrow, or Left dick on month, day or year field and
type new value

startdate:  [12/31/2010
enddate: | 2/19/2018
Find all occurences Cancel

Only checked fields are use by matching logic and search strings are ignored if present unless field
is checked.

The search logic is hard-coded for the most common cases. Select “Configure Filter Rule” button to
start dialog and select one of the preconfigured filter rules.

File Edit View Help
S]]+ ® All Mails
=T - Select filter fields F
=93 Linux1 | | date (Local) ¢ fro Find what Matchword ~ Match case size(kE) | ™
- EE— 31/12/2010 13:00_sh From shirshag75@gmai.com | O O
{3 attachmentmbox 04/01/2011 06:0 tation 8
-4 linux-1996-05.eml 09/01/2011 08:13| Select Filter Rule x 13
0 linux-2001-07.eml 07/12/2011 09:13] 13
linux-2002-02.eml X
=] 16/08/2015 1%:54 Select Predefined Filter Rule 8
16/08/2016 23:49 7
18/08/2016 14:33| @) ((From <—> To) and CC and BCC and Subject and (Message Text or Attachment Text) and Attachment Mame 21
18/08/2016 14:55 10
04/10/2015 15:23) () (From -> To) and CC and BCC and Subject and (Message Text or Attachment Text) and Attachment Name 7
05/10/2015 05:03| () ((From - (To or CC or BCC)) and Subject and (Message Text or Attachment Text) and Attachment Name 7 v
ISubject' newbid () {((From <~ To) and no CC and no BCC and Subject and (Message Text or Attachment Text) and Attachment Name
Date: 31/12/2010 13 (O {From - To) and no CC and no BCC and Subject and (Message Text or Attachment Text) and Attachment Name
() (From or To or CC or BCC) and Subject and (Message Text or Attachment Text) and Attachment Name
~
Hiall,
This is going 1o NOTE:
in Debian forus 1. (John <-> Tod) will match (Jon —> Tod) and (Tod —> John) mails
http://forums.d¢g 2. (John > Tod) will match Jon —> Tod mails
3. and no CC and no BCC will match mails without CC and BCC fields
This is from s 4, If field is not selected in the parent dialog, it is removed from the rule
5. If field is selected in the parent dialog and value set to =, it will match all mails with non empty field
<guote>
Hiall,
I am no prograr Cancel
or trunk builds amey 7
extremely poor and | startdate:  |12/31/2010
questions below :- —
end date: 2/19/2018
a IS_ there a wayng Find all occurences oK Cancel v
project progress as 1 . -
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More complex searching can be achieved by leveraging User Selected mails list. User can run
multiple advanced searches and merge results into User Selected Mails list.

9.28.2.1 Find all mails that don’t match option

User can check “Find all mails that don’t match” option to find mails that don’t match search
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criteria.

9.28.2.2 Handling of special “*’ search string

User can specify single “*’ character as the search string in any of the Filter fields to find subset of
mails as follows:

1. Find all mails that have CC header field by checking out CC check box only.
2. Find all mails that have BCC header field by checking only BCC check box only.

3. Find all mails that have at least one attachment by checking out Attachment Name check
box only.

4. Match all mails by checking out any of others check boxes only.

9.28.3 Search Reliability

MBox Viewer searching is Unicode based since version 1.0.3.40. The search string, mail header
fields and mail content are encoded first as Unicode UTF8 strings. Encoding into UT8 is done on
the fly in most cases.

Comparing Unicode strings has challenges since the same character may have multiple binary
representation. To overcome the problem, Unicode strings need to be normalized before they can be
compared. MBox Viewer relies on non-canonical normalization form KC. String normalization is
not without issues. To help to resolve or minimize issues, please create tickets and provide as
many details as possible to help to diagnose the issue.

In most cases the received mail data contains plain text and html text blocks. Both encode the
same/similar content. If the mail contains plain text blocks, only the plain text blocks will be
searched. If the mail doesn’t contain any plain text blocks, the html text blocks will be searched.

False positive results may sometimes happen when searching text/html content blocks. MBox
Viewer will attempt to extract text from html but the extraction solution is not perfect due to
simplistic but low cpu overhead approach.

9.28.4 Search for Words

Search for words is quite reliable for words composed from the following characters from ASCII
and ISO-8859-1 (Also known as ISO Latin 1) character sets:

"9123u56789abcdefghijklmnopqrstuvwxyz_ABCDEFGHIJKLMNOPQRSTUVWXYZAAAAAAECEEEEIIITDNOOOD

......

Any other characters from ASCII and ISO-8859-1 sets are considered as word delimiters.

Searching for words in other character sets/languages is currently not reliable for the following
reasons:

1. Some languages don’t have word delimiters
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2. Set of all UNICODE delimiters is very large and currently not known to MBox Viewer. Future
releases may enhance the search.

Option to search for words should not be set when searching emails not composed from ASCII and
ISO-8859-1 character sets.

9.28.5 Search Progress Bar

Search progress bar displays the progress along the configured search string and enables user to
cancel the search is so desired. The progress bar is not created unless a given search duration lasts
longer than the delay time controlled by -PROGRESS_BAR_DELAY command line option or
specified via GUI. Default value is 1 second.

9.28.6 Search Performance

Searching of header fields performs best since all fields reside in the memory.

Searching of messages and text attachments may take some time for very large files, say larger than
10-20 Gbytes. Search requires to read the content blocks from the email file and decode the content
when required. Worse case scenario is when the specified search string is not present in the mail
archive. When activated, the search progress bar shows the configured search string and enables
user to cancel the search is so desired.

Note that when searching of message and text attachments is configured, all mails will be sorted by
date first, except when sorted by conversations, to maximize search performance.

9.29 Refreshing Archive Tree Window

If an additional mbox or eml file is placed in the already selected folder, the Archive Tree window
needs to be refreshed to see the new additions. This can be done by selecting “Refresh” option
under the “File” drop menu or by clicking on the button showed below. Individual Folder can be
refreshed by the right click on the folder and selecting “Refresh Folder” menu option.
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(B mboxview - [u] x
File Edit View Help
RN @ &llMais O Found Mais User Selected Malls Help
=43 s | date (Local) 1 from o subject sre(E) | O
O\ppachembox 31272010 13100 shirish P <shi s nenbie subversion questions 7
) ttachment.mbox 04/01/201106:08 _René Hijortskov Nisksen <rene @hj... “Dariel Shahaf™ <d.s@daniel.sha...  Re: sunserve with cormupt imestamps and malformed text reprasentation 8
D liesc-1996-05.emi 09/01/201108:13 _kJL" <zhang.fan. work @ag. cor x
{0 linkpx-2001-07.eml | g 47/12/201103: 13 Péter SZABADY <Peter,SZABAD. . .apache.org” ... merge ermor 15
{2 linuy-2002-02.eml 16/08/2016 14:54  <webster. brent@rogers.com> Subversion Users <users@subvs My mixed revision working copy remains after a ‘svn update” 18
16/08/2016 23:49  Ryan Schmidt <subversion-2016...  webster.brent@rogers.com Re: My mixed revision working copy remains after a svn update' 7
\ 18/08/2016 1433 <webster.brent@rogers.con> Ryan schmidt <sub, 6. Re: My mixed Copy remains after a'svn update' 21
18/08/2016 1455 Johan Corveleyn <jcorvel@gmai...  webster,brent@rogers.com s My mixed revision warking copy remains after a 'svn update' 10
04/10/2016 15:23 “Rainer Senn” che.org>  TortoiseSVN RepoBrowser: Feature request for Search function 7
05/10/2016 05:03 Torsten Krah <krah.tm@omai.com: che.org Re: Tortoisesv Feature request for Search function 7 v
Subject: sun: REPORT request failed on “/svn/isun/be/xo00c
Date: 09/01/201108:13  From: "3/L" <zhang fanwork@qg.com>  Tos "users” <users@subversion.apache.org>
) ~
Hi, all.
Here is my preblem:
When I run svn log on my repository which version is 1.6.x with Apache 2.2 on Windows 2003 have suddenly begun getting an error message in their log
windows:
Error REPORT request failed on */[p be/21008 200 OK (ntep
Then I the log of apache, get like this
00:28 +0800] "OPTIONS HITP/1.17 401 401
00:28 ~0800] “OPTION
00:28 +0800] "PROPFIND
00:28 +0800] “PROPFIND
00:28 +0800] "PROPFIND
00:28 ~0800] "PROPFIND
00:28 +0800] “PROPFIND
00:28 ~0800] “PROPFIND
00:28 ~0800] “PROFFIND
00:28 +0800] "PROPFIND
00:28 ~0800] "PROPFIND
00:28 +0800] “PROPFIND v
00:28 ~0800] “PROPFIND
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9.30 Language (Character Sets) Support

9.30.1 Message Window

Different languages (character sets) are properly supported in the Message Window. This is thanks
to the Microsoft Web Browser emulation/control class integrated into the mboxview. The mboxview
generates the htm file from the mail’s body and Web Browser displays the generated file in the
Message window.

Display may not be correct if the character set for the mail’s body is not defined in the mail. To
resolve the incorrect display, you can try to apply different encoding by right clicking within the
window, selecting “encoding” and “more” options to apply different language.
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9.30.1.1 Header of Message Window

The text of the mail header fields is displayed correctly as long as the corresponding field encoding
type is present in the email.
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Two global options can be used to address incorrect field presentation in the Message Header in
case the field encoding is not present in the email. Missing field encoding type may or may not be a
problem. It should not be a problem if the default/local character set installed on your computer
matches the original encoding of the header fields. It might be an issue if you are receiving emails
from different countries.

As shown below, you can see all encoding/character sets applied to the header fields by enabling
“Show Charsets” option. To enable, select “Options” from the “File” drop menu and enable “Show
Charsets”.
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If the field text presentation is not correct, you can try to configure character set (or so called code
page according to Microsoft terminology) for the selected header fields and see if that helps. Per
field code pages can be configured via Options dialog box. Note that the user provided encoding
doesn't override encoding in the email, if present, which is denoted by the code page greater than
zero. Code Page set to zero indicates missing or unknown character set.

If you change the code page value(s) in the Options Dialog box, you need to refresh the selected
email by going up and down (or down and up).

All Windows supported code pages are listed in chapter 12 or can be viewed in the external
Browser by selecting “View” — ”View Code Page Ids”.

The character set information appears after the field title and is formatted as “(character set
name/code page)”. The “*” star character is appended after the code page if the user specified code
is applied). Example “(UTF-8/65001*)”.

The character set information after the “Date:’ title shows the local/default character set installed on
your computer.

9.30.2 Summary Window

Mail header fields are displayed correctly as long as the corresponding field encoding type is
present in the email.

9.31 Mail List Auditing

Mail list auditing capability enables users to compose mail list from all mails by merging results of
multiple searches and/or by merging one or more user selected mails.
To support list auditing, the Mbox Viewer maintains 3 internal mail lists:

* All Mails list is populated from the selected archive file under the Mail Tree.

* Found Mails list is populated by the search results. User can run Find Advanced dialog or
set the Find All Occurrences option in the Find dialog.

» User Selected Mails list is composed by a user from the mails in the All Mails and Found
Mails lists. Mails on All Mails and Found Mails lists are marked by the red vertical bar in
the first column if they are also on User Selected Mails list.

Each internal mail list has associated button in the dialog bar located next to the tool bar. When a
particular mail list is shown in the Mail Summary Window, associated button is highlighted.

Access to the User Selected Mails list is disabled upon startup and the associated Button gray out. It
can be enabled by the user to perform simple list auditing if desired by selecting View->User
Selected Mail List to enable/disable.

When User Selected Mails list is enabled, additional mail menu options will also be enabled such as
Copy Selected Mails to User Selected Mails.

Content of the User Selected Mails list is controlled by the user. User can merge search results with
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the content of the User Selected List.

User can run the search multiples time and merge results multiple times with the User Selected List.
Search results can be pruned before merging.

In addition, user has an option to select/highlight one or more mails in the Summary Mail Window
and copy to the User Selected Mails list.

Standard Windows method is used to select and highlight multiple mails, i.e. Shift+Left Click and
CTRL+Left Click and CTRL+A.

Merging/copying process will not create duplicate mails in the User Selected List.

User can select and highlight one or more mails in the Summary Mail Window and remove from the
active list. Mails can't be removed from the All Mails list.

All Mails list content persists until new mail archive is selected.
Found Mails list content persists until new search or when new mail archive is selected.

User Selected Mails list content persists until cleared by the user or new mail archive is selected.

9.31.1 Mail List Archiving

Found Mails list and User Selected Mails list content can be saved to new mbox archive files or just
to the .mboxlist mail list files.

Mail Archive and Mail List files will be created in the
FolderHousingMail Archives/ArchiveCache/Mail ArchiveName folder.

Archive file created from the Found Mails list will be created by appending _ FIND suffix to the
base name of the main archive file name.

The _USER suffix will be appended when creating archive file from the User Selected Mails list.

For example, if the main mbox archive file from Gmail is called "All mail Including Spam and
Trash.11.09.2018.mbox", then created archive file will be named "All mail Including Spam and
Trash.11.09.2018_USER.mbox."

When creation of the archive is completed, user is presented with the dialog to open the folder with
the created archive file or to open the archive file within the Mbox Viewer.

Separately, user can save mails in User Select Mails list to .mboxlist file, for example "All mail
Including Spam and Trash.11.09.2018_USER.mbox.mboxlist”. The .mboxlist files are much
smaller than the mail archive files. To protect against catastrophic failure of the mbox viewer while
saving mails to .mboxlist file, the mbox viewer maintains “All mail Including Spam and
Trash.11.09.2018_USER.mbox.mboxlist.bak1” and “All mail Including Spam and
Trash.11.09.2018_USER.mbox.mboxlist.bak2” files. To recover, user must copy one of these two
files to "All mail Including Spam and Trash.11.09.2018_USER.mbox.mboxlist” file.
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User can reload the last mail list file into the User Select Mails. Reload can be requested at any time
including after restart of the mbox viewer.

After mbox viewer is restarted or when User Selected Mails List is empty, User Selected Mails list
can be restored when All Mails list is active.

When User Selected Mails list is active and not empty, it can be reloaded by a user from the
last .mboxlist file.

WARNING: The .mboxlist file will no longer be valid if the master mail archive is changed.

9.31.2 Merging Multiple Mail Archives

9.31.2.1 Merging files using command line options

Multiple Mbox and Eml files (full path) can be listed in a file and concatenated into a single archive
file using two command line options.

-MBOX_MERGE_LIST_FILE=listFile Name and -MBOX_MERGE_TO_FILE=mergedFile
Name command line options to merge content of mbox files listed in the listFile Name. Wildcard
file names to merge are supported. The merged mbox file is automatically open in the Mbox
Viewer.

9.31.2.2 Merging files from GUI

Multiple archives can be concatenated into a single archive using "File -> Merge Archive Files"
option. This is useful if you need to analyze multiple mail views, provided as separate archive files,
derived from the same archive file.

After merging is completed, select "File -> Refresh" to request the Mbox Viewer to discover new

archive.
In order to remove duplicate mails from the concatenated file:

1. Select the created archive.

2. Select "View -> User Selected Mails" to enable User Select Mails list.

3. Right click on any mail to select "Copy All into User Selected Mails" option to copy all
mails into User Selected Mails list.

4. Click on the "User Selected Mails" button to select User Select Mails list.

5. Right click on any mail to select "Remove Duplicate Mails" option to remove duplicate
mails from User Select Mails list.

6. Mails are considered duplicate if the Date, From, To header fields and unique message ID
generated by the mail provider match.

7. Select "Save as Mail Archive file" option to save mails on the User Selected Mails list.

8. Select "File -> Refresh" to discover new no duplicate mails archive file by the Mbox Viewer.

9. You may want to rename the default name assigned to the archive file before the above step.
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9.32 Mail Printing Overview

Mbox Viewer supports printing of all, single or multiple mails to CSV, Text, HTML, PDF files and
to PDF printer. Mails can also be printed to PDF from any Web Browser by opening mails printed
to HTML files.

By default all, single or multiple mails are printed to single CSV, Text, HTML and PDF files
without any additional configuration or manual steps. However there is a limit how many mails can
effectively be printed to a single file. Option is provided to print mails to separate files to scale to
larger number of mails. See 9.32.7 section.

The next sections below will cover these limitations and alternate solutions.

9.32.1 Print Configuration Dialog

Many aspects of printing can be controlled via “File — Print Config” option. The dialog is shown
below and the usage is covered in the subsequent sections.

Print Configuration >
File Mame Configuration
Compose File Mame Template From

Date Time From To Subject Unigue Id
Max file path length supported by Windows is 260 characters

Wanted Max File Name Length

8

Adjusted Max File Mame Length 168
[]cusTOM TEMPLATE | Compose Custom Template
Print to .. Printer Menu Option Setup
() DO NOT PROMPT (@) PRINT PROMPT () PRINT PREVIEW
Page Setup
Print to .. PDF Menu Option Setup
() Chrome Browser (®) MSEdge Browser () User Defined Script

Path to Chrome/MSEdge Browser executable
| C:\Program Files (x86) Microsoft\Edge\Application\msedge.exe |

Path To User Defined Script
| F:\DocumentsYGIT1.0. 3. 27 \mboxviewer \Win32\Debug\scripts 'n,H'|

Print selected mails to separate files

eoF  [CIHTML Text
PDF document options
Mail Hdr Background Color Mail Body Background Color
Page Break After Each Mail  [_] Header and Footer
[[1Page Break After Each Conversation Thread

HTML/PDF Mail Header Configuration

cancel

9.32.1.1 Custom Name Template

User can create custom name template by checking “CUSTOM TEMPLATE” and then selecting
“Compose Custom Template”. User will be presented with the below template configuration dialog.
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Template Configuration X

Template Format

| %DATE_TIME%: %FROM_NAME% %TO_MAME%: %%SUBIECT % %eUNIQUE_ID %

Yo -%om-ed | Date and Time Format

From Address: User Account Mame @ [+] Domain Name To Address: User Account Name @ [+] Domain Name

[ Rreplace white spaces with underscore

Valid template format keywords that will be replaced by values from mail. UNIQUE_ID is generated by the mbox viewer to eliminate name dashes.
%DATE_TIME%: %FROM_MNAME%: %eFROM_ADDR%: %TO_MNAME%: %TO_ADDR%: %SUBIECT%: SeUNIQUE_ID%:

Keywords can be specified in any order. Any text can be specified between keywords.

Date and Time Format follows format accepted by the standard | srcftme | function. For example:
o' -Bom-Sod FoH: %6M: %S will expand to for example 2020-1-31 16:59:59

Cancel

9.32.2 Mail Printing to CSV Spreadsheet file

By default, Mbox Viewer supports printing of all mails or selected group of mails to a single CSV
file. All mails can be printed to single CSV file but a particular Spreadsheet tool may limit the
maximum supported size of the spreadsheet file.

User can select and print groups/subset of mails to separate CVS files as a work around. There is no
option to automatically split all mails into configurable number of mail groups for printing to
separate CSV files.

9.32.3 Mail Printing to TEXT file

By default Mbox Viewer supports printing of all, single or selected group of mails to single Text
file. All mails can be printed to single TEXT file but a particular Text viewer tool may limit the
maximum supported size of the text file.

User can select and print groups/subset of mails to separate Text files as a work around. There is no
option to automatically split all mails into configurable number of mail groups for printing to
separate Text files

9.32.4 Mail Printing to HTML file

By default Mbox Viewer supports printing of all mails, single or selected group of mails to single
HTML file. Mails can also be printed to a separate per mail HTML file for further processing as
described in “Mail Printing to PDF” 9.32.6 section and “Mail Printing to PDF files by Power
Users” 9.32.7 section.

All archive mails can be printed to single HTML file but HTML viewer tools/Web Browsers may
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not be able to process large HTML files, become very slow or completely overloaded.

User can select and print groups/subset of mails to separate HTML files as a work around. There is
no option to automatically split all mails into configurable number of mail groups for printing to
separate HTML files.

There is no hard rule how many mails can be printed to a single HTML file and viewed by a Web
Browser. It depends on the size and content (such as heavy graphics) of mails. It should be doable to
print up to a couple of thousands small to medium size text mails to a single HTML file for further
processing.

9.32.5 Mail Printing to PDF printer

Mbox Viewer supports printing of all, single or selected group of mails to PDF printer.

Printing to PDF printer relies on Microsoft HTML Document object to print its content. First,
Mbox Viewer will print mails to a single HTML file, then it will load this file into HTML
Document object and request the document object to print itself.

The limitations as far as the maximum number of mails that can be printed are described in the
"Printing Mails to HTML file" section.

The "File -> Print Config -> Page Setup" dialog option allows users to control the page title, header,
footer and background color.

By default user is prompted to select PDF printer for printing mails. If the PDF printer is configured
as the default printer, user can set "File -> Print Config -> Do Not Prompt" dialog option to skip the
printer prompt step.

9.32.6 Mail Printing to PDF file

Mbox Viewer supports multiple ways to print all, single or multiple mails to PDF file. All methods
convert HTML files, created first from mails by the Mbox Viewer, to PDF format.

By default all, single or selected mails are printed to a single HTML file and then converted to PDF
format. The default method limits the number of mails that can be effectively printed to single
HTML file as noted in previous sections. More scalable method for is described in “Mail Printing to
PDF files by Power Users” 9.32.7 section.

Mbox Viewer supports an option to print mails directly to PDF file without any user interaction.
Direct printing to PDF file invokes external application to convert HTML files to PDF. Standard
Google Chrome and/or Microsoft Edge browser in so called headless mode are used to perform
conversion. Using MS Edge allows users to configure printing of pages without header and footer.

Two additional options are provided to leverage developer version of the Google Chrome Canary
browser and free wkhtmltopdf application to covert HTML to PDF.

Options to leverage the Chrome Canary browser and wkhtmltopdf is provided since the standard
Chrome browser in the headless mode doesn't support options to control the page title, header and
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footer and the background color.
The Google Chrome Canary browser can be downloaded from Chrome Canary browser downloads.

User can set "File -> Print Config -> Path To User Defined Script" to invoke HTML2PDF-single-
wkhtmltopdf.cmd script included in the release package. HTML2PDF-single-wkhtmltopdf.cmd
script creates PDF files with the right footer "Page Number of Total Pages" and no page Title and
Header. The script can be customized by users if desired.

The wkhtmltopdf can be downloaded from wkhtmltopdf.org downloads.
The wkhtmltopdf command line options are documented in wkhtmltopdf.org usage.

User can replicate HTML2PDF-single-wkhtmltopdf.cmd or HTML2PDF-single-chrome-
canary.cmd script to a new file and customize to leverage different converter possibly commercial.
User will need to update "Path To User Defined Script" in "File -> Print Config" dialog to point to
new script path.

In order to leverage the Chrome Canary browser, user will need to update "Path To User Defined
Script" in "File -> Print Config" dialog to point to HTML2PDF-single-chrome-canary.cmd script.

When printing multiple mails to a single PDF file, user can

1. set "File -> Print Config -> Page Break After Each Mail" option to start each mail at new
page, or

2. set "File -> Print Config -> Page Break After Each Conversation Thread" to start
conversation or subject thread at new page.

User can unset "File -> Print Config -> Mail Hdr Background Color" option to remove mail header
background color and save on the ink when printing. Useful option when using Chrome browser to
print.

User can set/unset "File -> Print Config -> Header and Footer" option to control printing of page
header and footer via MS Edge browser.

Lastly, HTML files can be open within Firefox, Chrome, MS Edge, etc. Browser and printed to PDF
file. Note that in order for links to attachments be clickable the “Save to PDF” option must be
used when printing directly from Edge and Chrome browsers.

Note that links to attachments are clickable when PDF document is open in Edge or Chrome
browser but they are not clickable in Firefox.

9.32.6.1 Impact on Font Size when Printing of Multiple Mails to a Single
PDF

MBox Viewer's solution to Print multiple mails to single PDF is non-standard and can affect font
sizes in all mails. MBox Viewer concatenates content of all mails and headers in HTML format and
ask Edge or Chrome Web Browser to convert HTML document into PDF.

Some of mails may have complex style definitions and "pollute" environment of other mails.
Frequently, font sizes become smaller and may need to be zoomed in by the PDF viewer. There is
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no similar solution for zooming when printing generated PDF documents to paper.
The following approach is suggested when printing multiple mails into a single PDF.

1. Print mails using default mode. Right-click on selected mails and select "Print Selected Mails to

--> PDF --> Default". Evaluate generated PDF document and if not acceptable, follow step 2.

2. Print mails using Merge mode. Right-click on selected mails and select "Print Selected Mails to

--> PDF --> Merge" option. This will print all selected mails into separate PDF files first and then
merge them into a single target PDF file. Conversion of mails into PDF format by Edge or Chrome
Browsers is typically high quality and the merging process typically preserves original quality. Each
mail starts at the beginning of a page in the merged PDF. This may be considered less than optimal
for small mails. In order to run Merge mode, user must install free java PDFBox command line tool
and Java VM. Java VM is typically installed on Windows but PDFBox application must be
downloaded from the following link.

https://pdfbox.apache.org/download.html

Please download the latest pdfbox-app-3.*.jar file and install in the same directory as
mboxview.exe. Also, check whether java.exe is installed on your system as follow.

Start Command Prompt and type “where java”. If java.exe is not listed in the output, you need to
install java for Windows. You may also have to update PATH system environmental variable and
restart Explorer and MBox Viewer.

Note that in approach 1 and 2 you can configure MBox Viewer to print page break after each mail
or after each conversation thread of mails. Select "File- — Print Config-->PDF document options-
>Page Break After Each Mail/Page Break After Each Conversation Thread".

If none of the above print solutions works for you, you need to print each mail to a separate PDF
file and use a professional tool such as PDF-XChange Editor to merge generated PDF files into a
single PDF file. Reliability of these tools was not evaluated. To generate mails to separate PDF
files, select "File-->Print Config- — Print selected mails to separate files- - PDF".

Performance

Maximum number of mails that can be merged by 1 and 2 options depends on the complexity and
size of mails to be merged.

Merging may take minutes when merging relatively small plain text mails or it may take hours
when merging large number of business mails with hyperlinks, graphics, tables, etc.

For example, running option 2 (that is merge option), it took 3 hours to print 3926 mails, mix of
simple and business mails, into separate PDFs and another 40 minutes to merge them by PDFBox.
Task Manager was showing that PDFBox process memory utilization was close to 8gigabytes.

Option 1 never finished with the same set of mails. I canceled the test when it didn't finish within 5
hours.
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9.32.7 Mail Printing to PDF files by Power Users

NOTE: The below capability was implemented as “Print Selected Mails to ->PDF ->Merge”
option. The below description was left as an example to reuse with different PDF Merge application
if desired.

Some users may need to print larger number of mails to a single PDF file. This is supported by
Mbox Viewer but one or multiple manual steps are required. User must first print all mails to
separate PDF files and then merge them into a single PDF file by running provided script.

In order to print mails to separate PDF files, user must first set "File -> Print Config -> Print mails
to separate files -> PDF" option. After that, using standard mail print to PDF options, user can print
all or large subset of mails to separate PDF files into sub-folder PDF_GROUP created by Mbox
Viewer.

Printing large number of mails to separate PDF files is time consuming. Depending on the size and
content of a single mail, it may take fraction of a second to create PDF file or tens of seconds to
print single mail.

PDFMerge-pdfbox.cmd script included in the release package can be used to merge PDF files.
PDFMerge-pdfbox.cmd script invokes free PDFBox java tool to merge PDF files.

Free PDFBox java tool can be downloaded from pdfbox.apache.org.
PDFBox command line tools usage example can be found in pdfbox.apache.org commandline tools.

Java 8 can must be installed and can be downloaded from jdk8-downloads.

PDFMerge-pdfbox.cmd script must be copied into the directory housing all per mail PDF files and
executed. PDFMerge-pdfbox.cmd script will create one or more merged PDF files in the
PDF_MERGE sub-folder. If more than one merged PDF file is created in the PDF_MERGE sub-
folder, PDFMerge-pdfbox.cmd script needs to be copied to that sub-folder and script executed
again. The above steps need to be repeated until PDFMerge-pdfbox.cmd script creates single PDF
file only.

Printing mails to separate PDF files can also be done offline. User must first set "File -> Print
Config -> Print mails to separate files -> HTML" option. After that, using standard mail print to
HTML options, user can print all or large subset of mails to separate HTML files into sub-folder
HTML_GROUP created by Mbox Viewer.

HTML2PDF-all-chrome.cmd or HTML2PDF-all-wkhtmltopdf.cmd script included in the release
package can then be used to convert HTML files to PDF files. One of these scripts must be copied
into the directory housing all per mail HTML files, i.e. HTML_GROUP, and executed. Created PDF
files can then be merged into a single PDF file using PDFMerge-pdfbox.cmd script as described
above.

9.32.8 Mail Sharing with other People

The Mail Sharing (or Mail Export) feature enables users to share one or more of the selected mails
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with other people. The MBox Viewer will create the following files under ExportCache folder when
exporting one or more selected mails. Only files related to selected mails are exported.

1. The “Export selected single mail to a file” option. When single mail is exported the following
files are created:

a. Single SelectedMailName.htm file under ExportCache folder, where SelectedMailName is a
unique name constructed for the selected mail. User can define custom template for file
name via “File->Print Config->Custom Template->Compose Custom Template” dialog.

b. “Attachments” folder for all inline and non inline attachments.

2. The “Export selected multiple mails to separate files” option. When multiple mails are exported
to separate files the following files and folders are created:

a. The index.html file that shows all mails as the table with the following columns: attachment
indicator, Date, Subject, From and To.

b. “Mails” folder for all exported mails in Html format. MBox Viewer creates a separate file
for each exported mail as SelectedMailName.htm file, where SelectedMailName is a unique
name constructed for the selected mail. User can define custom template for file name via
“File->Print Config->Custom Template->Compose Custom Template” dialog.

c. “Attachments” folder for all inline non inline attachments

3. The “Export selected multiple mails to a single file” option. If multiple mails are exported to
single file the following files are created:

a. SelectedMailName.htm file under ExportCache folder, where SelectedMailName is a
unique name constructed for the selected mails being concatenated.

b. “Attachments” folder for all inline and non inline attachments

In all cases, the exportMails2Pdf.cmd file will also be created in the AttachmentCache folder to
create PDF file from mails when needed by a user. By default MBox Viewer doesn’t export mails in
PDF format since links to attachments are created as absolute links and work only on local
computer. Instead, MBox Viewer creates command script to enable users to create PDF files locally.
Edge or Chrome browser must be installed on the user computer.

MBox Viewer allows single export per mbox mail file at a time. If exported files exist already, user
is asked to copy ExportCache folder to another location, or to agree to override the existing export
folder, that is to delete existing files and create new files.

User can configure how to open linked documents via “Export Selected Mails-> Config” option, i.e.
links to attachments or links to mails in the index.html file. The same configuration options are
available via “Print Config->HTML/PDF Mail Header Configuration->How to open attachment
link” options. The options are persistent.
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9.32.9 Export and Print Directory Structure

MBox Viewer creates data directory and uses as target directory for files and sub-folders created by
MboxViewer such as “Print...” export all mails as eml files, etc

The DIRECTORY is constructed as follow based on the selected data folder:
DIRECTORY = UserSelectedDataFolder\UMBox Viewer\MappedMboxFilePath

Mapping example. Assuming

MboxFilePath=F:\Account\Inbox.mbox, then it will be mapped to

MappedMboxFilePath=F\ Account\Inbox-mbox

and DIRECTORY to

DIRECTORY=UserSelectedDataFolder\UMBox Viewer\F\ Account\Inbox-mbox

The “:’ character will be removed and “.mbox” extension, if present, will be mapped to “~-mbox”

DIRECTORY - target directory for files and sub-directories created by MBox Viewer
DIRECTORY\MailArchiveFilel.mbox

DIRECTORY \MailArchiveFilel.mbox.mboxview
DIRECTORY\MailArchiveFile2.mbox
DIRECTORY\MailArchiveFile2.mbox.mboxview

DIRECTORY\ImageCache
DIRECTORY\ImageCache\MailArchiveFilel- target directory for image files, such as png, jpg, etc, embeded into mails
DIRECTORY\ImageCache\Mail ArchiveFile2

DIRECTORY\ArchiveCache

DIRECTORY\ArchiveCache\MailArchiveFilel- target directory for saving Find Mails and User Selected Mails as .mbox archive files and .mboxlist
mail list files

DIRECTORY\ArchiveCache\Mail ArchiveFile2

DIRECTORY\PrintCache
DIRECTORY\PrintCache\MailArchiveFilel - target directory for printing to single CSV, TEXT, HTML and PDF files

DIRECTORY\PrintCache\MailArchiveFile1\PDF_GROUP - target directory for printing to separate PDF files

DIRECTORY\PrintCache\MailArchiveFile1\HTML_GROUP - target directory for printing to separate HTML files

DIRECTORY\PrintCache\Mail ArchiveFile2
DIRECTORY\AttachmentCache\MailArchiveFilel - target directory for all attachment files
DIRECTORY\AttachmentCache\Mail ArchiveFile2

DIRECTORY\EmlCache\MailArchiveFilel - target directory for all Eml files
DIRECTORY\EmlCache\MailArchiveFile2

DIRECTORY\LabelCache - target directory for all Label files
DIRECTORY\MergeCache - target directory for intermediate file created when “File- - Select root folder for merging” is selected.
DIRECTORY \ExportCache - target directory for exporting/sharing mails

DIRECTORY\ExportCache\Mails - target directory for mails encoded as HTML files.
DIRECTORY \ExportCache\Attachments - target directory for inline and non-inline attachments related to exported mails.

Mbox Viewer also creates and manages temporary directory C:\Users\UserName\AppData\Local\
Temp\mboxview directory to store temporary files (attachments, eml and htm) created when a
single mail is selected by the user.
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Mbox Viewer created help files such as MailListsInfo.htm and MboxviewerHelp.htm are stored in
the temporary directory C:\Users\UserName\AppData\Local\Temp\mboxview\MboxHelp directory.

10 Support for Read Only Media

MBox Viewer supports mbox mail archive files saved on Read Only media such as CDs.

MBox Viewer will create index files and other internal directories under the writable data directory
as described sections 9.32.9 and 9.6.

11 Forward Mails directly from MBox Viewer

11.1 Overview

Users can forward single or selected group of emails directly from MBox Viewer. MBox Viewer

connects to one of the preconfigured SMTP (Simple Mail Transport Protocol) Servers to forward

emails. Emails can be forwarded via Gmail, Yahoo, Outlook Live mail service or user configured
Mail Service.

MBox Viewer relies on a separate standalone process, ForwardEmlFile.exe, to connect to SMTP
Server and to send emails using the TLS encrypted communication. MBox Viewer links proven
MailKit software library to communicate with the SMTP server.

Note that ForwardEmlFile.exe can’t access user mail account data since SMTP Server can
send data only.

Be aware that all Mail Services impose limits on the rate, size of sending mails and other factors,
see chapter 11.3. For regular users, Gmail seems to offer better more predictable service than
Yahoo or Outlook. However, Yahoo supports mails up to 39MB in size vs 35MB by Outlook and vs
25MB by Gmail.

Note that even so Yahoo can send large mails of 39MB, Outlook may ignore mails larger than
35MB. When forwarding important emails, it is good idea to ask recipient for confirmation.

11.2 User Accounts and Passwords

Mail Service providers usually require third-party applications to follow special authentication
requirements in order to gain access to their services, i.e. to SMTP Server in this case.

If for whatever reasons you would rather not make changes to your main mail account, you can
always create additional mail account on another mail service just to be able forward emails directly
from MBox Viewer.

11.2.1 Yahoo Mail Service

In order for third-party SMTP client applications such as ForwardEmlFile.exe to access Yahoo
SMTP Server, user must login to Yahoo mail account first and generate one time App Password that
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can later be used to authenticate ForwardEmlFile application to SMTP Server.

App Password is long string of 16 random characters. Using App Password is very safe since it
practically can’t be guessed by hackers using brute force.

Select the below link and click on + sign next to “Generate an App Password” and follow all steps
to generate globally unique password for application named ForwardEmlFile. You will need App
Password and Yahoo mail user name to communicate with Yahoo SMTP Server.

https://my.help.yahoo.com/kb/account/generate-third-party-passwords-sln15241.html

11.2.2 Gmail Mail Service

Third-party SMTP client application such as ForwardEmlFile.exe can connect to Gmail SMTP

Server and be authenticated using either 1) Gmail user name and Gmail user password, or 2)
Gmail user name and Gmail App Password.

Note (Nov 2022). Authentication by user name and password is no longer supported by Gmail.

11.2.2.1 Gmail user didn’t enable 2-step verification to sign up into Gmail

In order to use Gmail user name and Gmail user password, user must login to the Gmail account
and enable “Less secure app access” option, see the link:

https://myaccount.google.com/lesssecureapps?pli=1

If you are concerned about this change, you can disable “Less secure app access” option after you
are done forwarding emails.

11.2.2.2 Gmail user did enable 2-step verification to sign up into Gmail

User must login to Google account and generate App Password for Gmail Account. App Password
is long string of 16 random characters. Using App Password is very safe since it practically can’t be
guessed by hackers using brute force.

Use the link below to generate App Password:

https://myaccount.google.com/security

Alternatively, user can login to Gmail account and the select “Manage your Google Account” by
clicking Google Account icon at the top right corner. Select Security option to generate 16-character
long App Password. See also helpful links below.

https://www.lifewire.com/get-a-password-to-access-gmail-by-pop-imap-2-1171882

https://www.systoolsgroup.com/gmail-backup/turn-off-two-step-verification.html

11.2.3 Outlook Live Mail Service

Testing was done using Outlook Live free mail account. Microsoft also offers payable Premium
Outlook mail service under Office 365 and Microsoft 365 plans. These plans offer much higher
sending limits but no evaluation was performed.
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If a user did enable 2-step versification, user needs to generate App Password to be properly
authenticated, see chapter 11.2.3.2 . App Password is long string of 16 random characters. Using
App Password is very safe since it practically can’t be guessed by hackers using brute force.

If a user didn’t enable 2-step versification, there is no requirement to change any security setting for
Outlook Live account to be able to send mails via Outlook SMTP Server.

Creating User name and Password to gain access to Outlook SMTP is not exactly clear and can be

confusing to set up.

11.2.3.1 Create Outlook Account, User Name and Password

I suggest the following steps to create valid user names and password. For more information,
examine the following link.

Evervthing vou need to know about Microsoft accounts | Windows Communit
In my case I already had Microsoft and Outlook accounts but had to perform additional

configuration.

11.2.3.1.1 You don’t have Microsoft Account (know as MSA) and you don’t have
Outlook Live account

Use the following link to create Microsoft account page:

https://account.microsoft.com/account

Select “Sign in”, then select “Create one!”, then select “Get a new email address” and create your
new MyName@outlook.com email address.

The below link has more details.

https://support.microsoft.com/en-us/account-billing/how-to-create-a-new-microsoft-account-

a84675c3-3e9e-17cf-2911-3d56b15c0aaf

Use your new Outlook User name and Password to open SMTP Server Configuration dialog and
configure user name and password. Attempt to forward one of the mails and check if all works.

11.2.3.1.2 You already have both Microsoft Account and Outlook Live Account
This is the case I faced. Forwarding of emails was not working properly until I created email alias
and make this alias primary as described in following link:

https://support.microsoft.com/en-us/office/add-or-remove-an-email-alias-in-outlook-com-

459b1989-356d-40fa-a689-8f285b13f1£2

For some reason, Outlook Account User Name and Password did not work for me but Microsoft
Account User name and Password did work.

11.2.3.2 Generate App Password for Outlook

User must login to Outlook account, enable 2-step verification and generate App Password for
Outlook Account. Follow the link below to generate App Password:

55


https://support.microsoft.com/en-us/office/add-or-remove-an-email-alias-in-outlook-com-459b1989-356d-40fa-a689-8f285b13f1f2
https://support.microsoft.com/en-us/office/add-or-remove-an-email-alias-in-outlook-com-459b1989-356d-40fa-a689-8f285b13f1f2
https://support.microsoft.com/en-us/account-billing/how-to-create-a-new-microsoft-account-a84675c3-3e9e-17cf-2911-3d56b15c0aaf
https://support.microsoft.com/en-us/account-billing/how-to-create-a-new-microsoft-account-a84675c3-3e9e-17cf-2911-3d56b15c0aaf
https://account.microsoft.com/account
https://community.windows.com/en-us/stories/everything-you-need-to-know-about-microsoft-accounts

https://support.microsoft.com/en-us/account-billing/using-app-passwords-with-apps-that-don-t-

support-two-step-verification-5896ed9b-4263-e681-128a-a6f2979a7944

11.3 Mail Sending and Size Limits

The limits are listed here to the best of our knowledge and they might be changed by the mail
service providers anytime without notice. For regular users, Gmail seems to offer better more
predictable service than Yahoo or Outlook. However, Yahoo supports mails up to 39MB in size vs
35MB by Outlook and vs 25MB by Gmail.

Users are mainly responsible for observing sending limits. MBox Viewer will limit the sending rate
to 30 mails/minute.

11.3.1 Gmail Mail Service

Sending can be rejected by Gmail for variety of reasons. If a user exceeds various limits, user
account can be locked for up to 24 hours. User can take manual steps to restore access.

Regular users are allowed to send up to 500 mails per day.
Mails can be rejected if they are being sent too fast or to too many recipients.

Mails of up to 25MB are accepted.

11.3.2 Yahoo Mail Service

Sending can be rejected by Yahoo for variety of reasons. If a user exceeds various limits, user
account can be locked for up to 24 hours. User can take manual steps to restore access.

Yahoo does not disclose sending and size limits.

Mails of up to 39MB are accepted.

11.3.3 Outlook Mail Service

Sending can be rejected by Outlook for variety of reasons including suspicion of spamming. If a
user exceeds various limits, user account can be locked for up to 24 hours. User can take manual
steps to restore access.

Mails of up to 35MB are accepted. If you attempt to send larger mail, it will appear that the sending
was successful. However, Outlook will post rejection mail into your Outlook account.

The other sending limits are not known.

11.4 SMTP Server Configuration

Select “File -~ SMTP Mail Server Config” to open the configuration dialog. Select one of the
listed mail services, enter User Account and Password and click on the “Save” button to save the
changes.
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When you select “Close” button, the SMTP.ini file is created for the selected service in C:\Users\
%USERNAME%\AppData\Local\MBoxViewer\MailService and used by ForwardEmlFile.exe to

support forwarding of emails.

The “Cancel” button is used to clear unsaved changes made in the dialog. If you switch to different

mail service, the unsaved changes in the dialog are lost.

When you exit MBox Viewer, User Password is not saved in the system for safety reasons and must
be reentered before any mail can be forwarded again.

SMTP Mail Server Configuration

Please read the overview first —-= Help

Mail Service

® Gmail () Yahoo () Outock (C)Custom

SMTP Server Addres

Mame | smtp.gmail . com

Fort 537

SMTP Server Connection Encryption Type

StartTls o

SMTP User

Account | |

Paszzword |

Max Mail Size in KB | 25530

Reset Max Mail Size to Default

Close Save

Cancel

11.4.1 SMTP Servers Default Settings

SMTP Server Address |smtp.gmail.com smtp.mail.yahoo.com |smtp-mail.outlook.com
SMTP Server Port 587 587 587

SMTP Security StartTls StartTls StartTls

11.5 Forwarding Mails

MBox viewer supports forwarding of a single and multiple emails.

Note that From address can be specified by a user while in Custom SMTP Configuration

option only.

11.5.1

Forwarding a single email

Right click on any email and select “Forward Mail” option to open the dialog to forward the
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selected email. The dialog can be manually resized if needed.

Forward Mail O X

Service:  Gmail

Subject: |Re: svnserve with corrupt tmestamps and malformed text representation

From: | john.silver @gmai.com

T tom. field@gmail. com

cC barbara, forest@amail.com

BCC:

User Text:

Please review the attachment and provide feedback.

Thank you,
John

Clear Cancel

The non-empty To field is required. Other fields are optional. When you open the dialog, To, CC,
BCC and User Text fields will show the values set in the last dialog. You can clear these fields by
clicking on the “Clear” button.

It is important to make sure all addresses are correct and valid. If any address is not valid, a
rejection email will be send by the mail service to the respective user’s mail account. MBox Viewer
doesn’t have access to user’s mail accounts.

11.5.2 Forwarding a list of selected emails

User can select multiple email, then right click on any of the selected emails and select “Forward
Mails” option to open the dialog to forward the selected email.

To avoid suspension of the user account, the user is warned if the user attempts to forward batch of
emails larger than 100. User is also warned when any of the select mails to forward is larger than
supported maximum size.
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11.5.3 Error Reporting

If forwarding of a mail fails, MBox Viewer will create Message Box with relevant error text.

12 Windows Code Page Identifiers

The table below shows the supported character sets/code pages by Windows platform. The list is
based on the following link.

https://msdn.microsoft.com/en-us/library/windows/desktop/dd317756(v=vs.85).aspx

Code Page Name Display Name

37 IBMO037 IBM EBCDIC (US-Canada)
437 IBM437 OEM United States

500 IBM500 IBM EBCDIC (International)
708 ASMO-708 Arabic (ASMO 708)

720 DOS-720 Arabic (DOS)

737 ibm737 Greek (DOS)

775 ibm775 Baltic (DOS)

850 ibm850 Western European (DOS)

852 ibm852 Central European (DOS)

855 IBM855 OEM Cyrillic

857 ibm857 Turkish (DOS)

858 IBM00858 OEM Multilingual Latin I

860 IBM860 Portuguese (DOS)

861 ibm861 Icelandic (DOS)

862 DOS-862 Hebrew (DOS)

863 IBM863 French Canadian (DOS)

864 IBM864 Arabic (864)

865 IBM865 Nordic (DOS)

866 cp866 Cyrillic (DOS)

869 ibm869 Greek , Modern (DOS)

870 IBM870 IBM EBCDIC (Multilingual Latin-2)
874 windows-874 Thai (Windows)

875 cp875 IBM EBCDIC (Greek Modern)
932 shift_jis Japanese (Shift-JIS)

936 gb2312 Chinese Simplified (GB2312)
949 ks_c_5601-1987 Korean

950 big5 Chinese Traditional (Big5)
1026 IBM1026 IBM EBCDIC (Turkish Latin-5)
1047 IBM01047 IBM Latin-1

1140 IBM01140 IBM EBCDIC (US-Canada-Euro)
1141 IBM01141 IBM EBCDIC (Germany-Euro)
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Code Page Name Display Name

1142 IBM01142 IBM EBCDIC (Denmark-Norway-Euro)
1143 IBM01143 IBM EBCDIC (Finland-Sweden-Euro)
1144 IBM01144 IBM EBCDIC (Italy-Euro)
1145 IBM01145 IBM EBCDIC (Spain-Euro)
1146 IBM01146 IBM EBCDIC (UK-Euro)

1147 IBMO01147 IBM EBCDIC (France-Euro)
1148 IBM01148 IBM EBCDIC (International-Euro)
1149 1BMO01149 IBM EBCDIC (Icelandic-Euro)
1200 utf-16 Unicode

1201 unicodeFFFE Unicode (Big-Endian)

1250 windows-1250 Central European (Windows)
1251 windows-1251 Cyrillic (Windows)

1252 Windows-1252 Western European (Windows)
1253 windows-1253 Greek (Windows)

1254 windows-1254 Turkish (Windows)

1255 windows-1255 Hebrew (Windows)

1256 windows-1256 Arabic (Windows)

1257 windows-1257 Baltic (Windows)

1258 windows-1258 Vietnamese (Windows)

1361 Johab Korean (Johab)

10000 macintosh Western European (Mac)
10001 X-mac-japanese Japanese (Mac)

10002 x-mac-chinesetrad Chinese Traditional (Mac)
10003 X-mac-korean Korean (Mac)

10004 x-mac-arabic Arabic (Mac)

10005 x-mac-hebrew Hebrew (Mac)

10006 x-mac-greek Greek (Mac)

10007 x-mac-cyrillic Cyrillic (Mac)

10008 x-mac-chinesesimp Chinese Simplified (Mac)
10010 X-mac-romanian Romanian (Mac)

10017 x-mac-ukrainian Ukrainian (Mac)

10021 x-mac-thai Thai (Mac)

10029 X-mac-ce Central European (Mac)

10079 x-mac-icelandic Icelandic (Mac)

10081 x-mac-turkish Turkish (Mac)

10082 X-mac-croatian Croatian (Mac)

12000 utf-32 Unicode (UTF-32)

12001 utf-32BE Unicode (UTF-32 Big-Endian)
20000 x-Chinese-CNS Chinese Traditional (CNS)
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Code Page Name Display Name

20001 x-cp20001 TCA Taiwan

20002 x-Chinese-Eten Chinese Traditional (Eten)

20003 x-cp20003 IBM5550 Taiwan

20004 x-cp20004 TeleText Taiwan

20005 x-cp20005 Wang Taiwan

20105 x-IA5 Western European (IA5)

20106 x-IA5-German German (IA5)

20107 x-IA5-Swedish Swedish (IA5)

20108 x-IA5-Norwegian Norwegian (IA5)

20127 us-ascii US-ASCII

20261 x-cp20261 T.61

20269 x-cp20269 ISO-6937

20273 IBM273 IBM EBCDIC (Germany)

20277 IBM277 IBM EBCDIC (Denmark-Norway)
20278 IBM278 IBM EBCDIC (Finland-Sweden)
20280 IBM280 IBM EBCDIC (Italy)

20284 IBM284 IBM EBCDIC (Spain)

20285 IBM285 IBM EBCDIC (UK)

20290 IBM290 IBM EBCDIC (Japanese katakana)
20297 IBM297 IBM EBCDIC (France)

20420 IBM420 IBM EBCDIC (Arabic)

20423 IBM423 IBM EBCDIC (Greek)

20424 IBM424 IBM EBCDIC (Hebrew)

20833 x-EBCDIC-KoreanExtended IBM EBCDIC (Korean Extended)
20838 IBM-Thai IBM EBCDIC (Thai)

20866 koi8-r Cyrillic (KOI8-R)

20871 IBM871 IBM EBCDIC (Icelandic)

20880 1BM880 IBM EBCDIC (Cyrillic Russian)
20905 IBM905 IBM EBCDIC (Turkish)

20924 IBM00924 IBM Latin-1

20932 EUC-JP Japanese (JIS 0208-1990 and 0212-1990)
20936 x-cp20936 Chinese Simplified (GB2312-80)
20949 x-cp20949 Korean Wansung

21025 cpl1025 IBM EBCDIC (Cyrillic Serbian-Bulgarian)
21866 koi8-u Cyrillic (KOI8-U)

28591 is0-8859-1 Western European (ISO)

28592 is0-8859-2 Central European (ISO)

28593 is0-8859-3 Latin 3 (ISO)

28594 is0-8859-4 Baltic (ISO)

61




Code Page Name Display Name

28595 is0-8859-5 Cyrillic (ISO)

28596 is0-8859-6 Arabic (ISO)

28597 is0-8859-7 Greek (ISO)

28598 is0-8859-8 Hebrew (ISO-Visual)

28599 is0-8859-9 Turkish (ISO)

28603 is0-8859-13 Estonian (ISO)

28605 is0-8859-15 Latin 9 (ISO)

29001 x-Europa Europa

38598 is0-8859-8-i Hebrew (ISO-Logical)

50220 is0-2022-jp Japanese (JIS)

50221 csIS02022JP Japanese (JIS-Allow 1 byte Kana)
50222 is0-2022-jp Japanese (JIS-Allow 1 byte Kana - SO/SI)
50225 is0-2022-kr Korean (ISO)

50227 x-cp50227 Chinese Simplified (ISO-2022)
51932 euc-jp Japanese (EUC)

51936 EUC-CN Chinese Simplified (EUC)
51949 euc-kr Korean (EUC)

52936 hz-gb-2312 Chinese Simplified (HZ)
54936 GB18030 Chinese Simplified (GB18030)
57002 x-iscii-de ISCII Devanagari

57003 x-iscii-be ISCII Bengali

57004 X-iscii-ta ISCII Tamil

57005 x-iscii-te ISCII Telugu

57006 x-iscii-as ISCII Assamese

57007 x-iscii-or ISCII Oriya

57008 x-iscii-ka ISCII Kannada

57009 x-iscii-ma ISCII Malayalam

57010 x-iscii-gu ISCII Gujarati

57011 X-iscii-pa ISCII Punjabi

65000 utf-7 Unicode (UTF-7)

65001 utf-8 Unicode (UTF-8)

12.1 Handling Unknown Code Page Names

In a few cases, mboxview will map unknown code names to the equivalent code names supported

by Windows.

Unknown Code Name

Mapped To Code Name

gbk

GB18030
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cpl252

Windows-1252

ascii us-ascii
cp819 iso0-8859-1
latinl is0-8859-1
latin2 iso0-8859-2
big-5 bigh

SJIS shift_jis
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